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Adaptec Software License Agreement

In return for acquiring a license to use the software
(“Software”) and related documentation, you agree to the
following terms and conditions:

1 License.  This Agreement grants you, the Licensee, a
license to: (a) use the software on a single computer
system or, in the case of a multiuser or networked
system which permits access to the Software by more
than one user at the same time, at a single working
location; and (b) make one copy of the Software in
machine readable form solely for back-up purposes
provided you reproduce Adaptec’s copyright notice
and any proprietary legends.

2 Restrictions. You may not distribute copies of the
Software to others or electronically transfer the
Software from one computer to another over a
network.  You may not use the Software from multiple

location of a multiuser or networked system at any
time.  The Software contains trade secrets and in order
to protect them you may not decompile, reverse
engineer, disassemble, or otherwise reduce the
Software to a human-perceivable form.  YOU MAY
NOT MODIFY, ADAPT, TRANSLATE, RENT,
LEASE, LOAN, RESELL FOR PROFIT,
DISTRIBUTE, NETWORK OR CREATE
DERIVATIVE WORKS BASED UPON THE
SOFTWARE OR ANY PART THEREOF.

3 Ownership of Software.  As Licensee, you own the
media upon which the software is recorded or fixed,
but Adaptec retains title and ownership of the
Software recorded on the original media and all
subsequent copies of the Software, regardless of the
form or media in which or on which the original and
other copies may exist.  This license is not a sale of the
Software or any copy.

4 Confidentiality.  You agree to maintain the Software in
confidence and to not disclose the Software to any
third party without the express written consent of
Adaptec, You further agree to take all reasonable
precautions to preclude access of unauthorized
persons to the Software.

5 Term.  This license is effective until January 1, 2045,
unless terminated earlier.  You may terminate the
license at any time by destroying the Software
(including the related documentation) together with
all copies or modifications in any form.  Adaptec will
have the right to terminate your license immediately if
you fail to comply with any term or condition of this
Agreement.  Upon any termination, including
termination by you, you must destroy the Software
(including the related documentation) together with
all copies or modifications in any form.

6 Limited Warranty.  Adaptec warrants only that the
media upon which the Software is furnished will be
free from defects in material or workmanship under
normal use and service for a period of thirty (30) days
from the date of delivery to you.  ADAPTEC DOES
NOT AND CANNOT WARRANT THE
PERFORMANCE OR RESULTS YOU MAY
OBTAIN BY USING THE SOFTWARE OR
DOCUMENTATION.  THE FOREGOING STATES
THE SOLE AND EXCLUSIVE REMEDIES
ADAPTEC WILL PROVIDE FOR BREACH OF
WARRANTY.  EXCEPT FOR THE FOREGOING
LIMITED WARRANTY, ADAPTEC MAKES NO
WARRANTIES, EXPRESS OR IMPLIED, AS TO
NONINFRINGEMENT OF THIRD PARTY
RIGHTS, MERCHANTABILITY OR FITNESS FOR
A PARTICULAR PURPOSE.  Some states do not



allow the exclusion of implied warranties or
limitations on how long an implied warranty may last,
so the above limitations may not apply to you.  This
warranty gives you specific legal rights and you may
also have other rights which vary from state to state.

7 Limitation of Liability.  IN NO EVENT WILL
ADAPTEC BE LIABLE TO YOU FOR ANY
SPECIAL DAMAGES, INCLUDING ANY LOST
PROFITS, LOST SAVINGS OR OTHER
INCIDENTAL OR CONSEQUENTIAL DAMAGES,
EVEN IF ADAPTEC HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES, OR
FOR ANY CLAIM BY ANY OTHER PARTY.  Some
states do not allow the exclusion or limitation of
special, incidental, or consequential damages, so the
above limitation or exclusion may not apply to you.

8 Limitation of Remedies.  Adaptec’s entire liability and
your exclusive remedy shall be: (a) the replacement of
any media not meeting Adaptec’s limited warranty
which is returned to Adaptec; or (b) if Adaptec or its
distributor is unable to deliver replacement media
which is free of defects in materials or workmanship,
you may terminate this Agreement by returning the
Software and your money will be refunded.

9 Export.  You acknowledge that the laws and
regulations of the United States restrict the export and
re-export of the Software.  You agree that you will not
export or re-export the Software or media in any form
without the appropriate United States and foreign
government approval.

10 Government Restricted Rights Legend for Units of the
DoD. Use, duplication or disclosure by the
Government is subject to restrictions as set forth in
subparagraph (c)(1)(ii) of the Rights in Technical Data
and Computer Software clause at 252.227-7013.
Adaptec, Inc., 691 South Milpitas Boulevard,
Milpitas, California 95035.

11 Government Restricted Rights Legend for Civilian
Agencies.  Use, reproduction or disclosure is subject
to restrictions set forth in subparagraphs (a) through
(d) of the Commercial Computer Software -
Restricted Rights clause at 52.227-19 and the
limitations set forth in Adaptec, Inc. is standard
commercial agreement for this software. Unpublished
- rights reserved under the copyright laws of the
United States.

12 General.  You acknowledge that you have read this
Agreement, understand it, and that by using the
software you agree to be bound by its terms and
conditions.  You further agree that it is the complete
and exclusive statement of the agreement between

Adaptec and you which supersedes any proposal or
prior agreement, oral or written, and any other
communication between Adaptec and you relating to
the subject matter of this Agreement.  No variation of
the terms of this Agreement or any different terms will
be enforceable against Adaptec unless Adaptec gives
its express consent, including an express waiver of the
terms of this Agreement, in a writing signed by an
officer of Adaptec.  You assume full responsibility for
the use of the Software and agree to use the Software
legally, and responsibly.  This Agreement shall be
governed by California law except as to copyright
matters which are covered by Federal law.  This
Agreement is deemed entered into at Milpitas,
California by both parties.  Should any provision of
this Agreement be declared unenforceable in any
jurisdiction, then such provision shall be deemed to be
severable from this Agreement and shall not affect the
remainder hereof.  All rights in the Software not
specifically granted in this Agreement are reserved by
Adaptec.

13 Should you have any questions concerning this
Agreement, you may contact Adaptec by writing to:
Adaptec, Inc., Legal Department, 691 South Milpitas
Boulevard, Milpitas, California 95035.
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Chapter 1: Introduction
____________________________________________________________________

About the Software

Thank you for purchasing Toast 3.5, the world’s leading CD mastering software for the
Macintosh. Toast is loaded with powerful features that will make your work easier. To get the
most out of your new software, please take some time to review this manual. If you encounter
any problems while setting up or using Toast, help is available by telephone or 
e-mail (see below for details.)

Toast lets you create CDs in many popular formats:

• Mac Files & Folders, which lets you easily create an HFS CD containing any files or 
folders you choose.

• Mac Volume, which is used to copy an entire volume or partition to a CD in HFS format.

• ISO 9660, for making CDs which are compatible with a wide range of systems, including
DOS, Windows, Unix, Macintosh and more. Now includes Joliet support for Windows 95
and WindowsNT.

• Mac/ISO Hybrid, combines the benefits HFS and ISO on a single disc. Toast even lets
you define “shared” data to save disc space.

• Audio CD for creating your own audio CDs from existing CDs or from standard sound
files which can be played in any standard CD player.

• CD-i for writing pre-authored CD-i images to disc.

• Enhanced Music CD (CD EXTRA) format that combines audio tracks and data.

• Video CD, creates CDs which can be played by Video CD or CD-i players.

• SCSI Copy for making a direct copy of a hard drive or CD.

• Disc Image format allows you to write previously created disc images to disc (such
images can be created with Toast, or by other applications.)

• Multitrack CD-ROM XA for writing existing XA tracks to disc.

• Mixed Mode, combines data in HFS, ISO or any other format and audio tracks.

Each feature and function of Toast is covered in detail in this manual. You may want to give
special attention to these features:

• Drag & Drop

• Disc Images – Chapter 15 "The File Menu" 

• Temporary Partitions – Chapter 15 "The Utilities Menu" 
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• Optimize on-the-fly – Chapter 16 “The Mac Volume Format”

• Mounting Disc Images – Chapter 15 “The Utilities Menu”

• Saving virtual images – Chapter 15 “The File Menu”

• Check Speed – Chapter 17

• Simulation Mode – Chapter 17

• AppleScript – Chapter 20

• Verification – Chapter 17

• Compare – Chapter 15 "The Utilities Menu"

• Autoloaders – Chapter 15 “The Utilities Menu”

• Shared data on hybrid discs – Chapter 6

New in version 3.5

In addition to the major enhancements introduced in version 3.0, Toast 3.5 adds several

important new features based on user feedback:

• Toast’s Greatest Hits - Allows you to easily create your own compilation audio discs by
combining your favorite tracks from your CDs. Tracks can be copied directly from audio
discs without having to save them on your hard drive.*1

• Audio Extraction- Save tracks from audio discs as standard AIFF sound files on your
hard drive.1

• Joliet support in ISO 9660 format. 

• Support for Rewriteable drives. 

* requires SCSI Manager 4.3

1  requires a CD-ROM drive which supports audio extraction

____________________________________________________________________________

Updates

Adaptec is committed to continuous improvement of all our products. We occasionally release
updates to our software to incorporate support for new recorders and to correct any reported
bugs. These updaters are available directly from our web site at http://www.adaptec.com

____________________________________________________________________________
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Registration

To qualify for technical support and to insure that you receive notification of new versions,
please mail the registration card which came with the software.

About the Manual

The manual is divided into 4 parts:

• Introduction & Basics, which covers installation of the software.

• Writing CDs in different formats, which gives step-by-step instructions for writing CDs in
each of the supported formats.

• Reference, which covers every format and menu command in detail.

• Frequently Asked Questions, which answers common questions and provides tips for
troubleshooting problems.

____________________________________________________________________________

Installing the Software

Run the Installation Program
The Toast installation disc includes installers in several languages. Each installer is contained
in its own folder. Insert the Toast disc in your CD-ROM drive, locate and open the appropriate
language folder and double-click the TOAST INSTALLER within. Follow the on-screen
instructions to install Toast on your hard drive.

➤ Note Toast is a “FAT” binary, so the same application runs on either Power Macintoshes or 68K
Macintoshes.

About Toast CD Reader Extension
The Toast CD Reader extension will automatically be installed in your Extensions folder. It
allows you to use your CD recorder as a CD reader.

Note: Toast CD Reader is not required for writing CDs.
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Running the Software

Start Toast by double-clicking its icon.

The first time you run Toast, you will need to personalize the software.

After you have entered the personalization information, the main window will appear.

The main functions of Toast are all easily accessible from the main window. 
• The upper part of the window gives information about the CD format and any data which
you have selected. This information includes how much data is selected and the total running
time for the selected data. 
• The lower part shows information related to your CD recorder, including SCSI ID and
recorder brand and model.

6 Installing the Software
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Chapter 2: CD Terminology and 
Background

____________________________________________________________________________

About CDs

A CD (compact disc) is 1.2 mm thick and has a diameter of 8 or 12 cm. Its data capacity is
approximately 650 MB for 74-minutes discs and 550 MB for 63-minutes discs. The exact
capacity varies from one brand of media to another.

The access time and data-transfer rate of a CD is typically much slower than a hard disk, 
although technological improvements have resulted in CD-ROM readers that read up to 8
times faster than the original single-speed drives.

The recordable part of a disc consists of (at least) three blocks:

1) Lead-In block: holds the directory information; located on the innermost 4 mm of the
disc’s recording surface.

2) Program block: holds the data or audio tracks and fills the next 33 mm of the disc.

3) Lead-Out block: marks the end of the CD and fills the external 1 mm.

A CD is divided into sectors. The actual available size for data is 2352 bytes for each sector. 

Different CD formats use that 2352 bytes in different ways. For example, an audio-CD uses
all 2352 bytes for audio data, while data formats need several bytes for error detection and
correction.

Each sector of a CD is again divided into logical blocks of 512, 1024 or 2048 bytes. The
block sizes are part of the definition for each CD format. 

There are 5 different types of sectors:

2352 Audio Sample Bytes

Sync
12

Header
4

Data
2048

Error correction
288
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Type 1 are audio sectors; they only contain audio samples (1 Sample = 4 bytes).

Type 2 to 5 are data sectors which are used to store computer data (types 2 and 4) or
compressed audio and video data (type 5). (Type 3 is very rarely used.)

The standard recordable discs (12 cm of diameter) can hold 63 or 74 minutes of data. The
capacity of a CD is measured in time (minutes:seconds:frames - 1 frame = 1 sector) rather
than megabytes since CDs were originally conceived to only store audio data. 

The data for Audio CDs is 16 bit/44.1 kHz, stereo, i.e. each audio sample occupies 4 bytes (16
bits = 2 bytes per channel) and one second of audio contains 44,100 samples. Since an audio
sector (type 1; 2352 bytes/sector) only contains audio samples: 2352/4 = 588 samples/sector.
One second contains 75 sectors: 44.100/588 = 75 sectors/second. Therefore a 74 min. CD-R
contains 333,000 sectors (4,440 * 75).

The number of megabytes a CD can hold depends on on the type of sectors used on the disc:

• If only type 1 sectors are used, these 333,000 sectors correspond to approx. 747 MB of
audio data (333,000 * 2352 bytes).

• If types 2 or 4 are used they correspond to approx. 650 MB of data (333,000*2048 bytes).

If a disc is read with a standard, single speed CD-ROM drive 150 kilobytes of data are read
per second (75 sectors * 2048 bytes in one second). 

Sync
12

Header
4

Data
2336

Sync
12

Header
4

Subheader
8

Data
2048

EC
280

Sync
12

Header
4

Subheader
8

Data
2324

EC
4
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Terminology

AIFF

"Audio Interchange File Format". Created by Apple as a standard file format for saving sound
files of any type.

Audio Sectors

Audio sectors are made up of the sound data you hear plus error correction data. Audio sectors
cannot be read with a standard CD-ROM drive. Many CD-ROM drives do however offer the
ability to convert audio data to computer data. (see previous section “About CDs”).

Audio Tracks

Audio tracks are simply a collection of audio sectors. These tracks are playable on standard
audio-CD-players. For the audio-CD players to be able to recognize and play the tracks, the
tracks must always be in the FIRST session on the CD.

Blue Book

The Blue Book specifies the CD EXTRA standard for interactive CDs. A CD EXTRA (also
known as Enhanced CD) is a multisession CD which contains audio tracks in its first session
followed by a data track in the second session.

CD

A CD (Compact Disc) consists of up to approx. 333,000 sectors. A CD can be recorded in one
of two ways with Toast: track-at-once or disc-at-once.

CD Extra - see Enhanced Music CD

CD-i

CD-i (Compact Disc Interactive) is a computer system developed by Philips. It is able to read
discs in the following formats: CD-i, Video CD and Photo CD. A disc in CD-i format consists
of one CD-i track with mode 2 sectors (types 4 and 5, see previous section “About CDs”). A
CD-i is specified in the “green book”. Opposed to other CD-ROM XA discs, a CD-i track has
no entry in the TOC.

CD-Recordable (CD-R)

CD recordables are special compact discs which can record data by using a special laser that
“burns” microscopic holes in the recording layer. These pits can then be read by standard CD
readers. Recordable CDs are somewhat more fragile than standard CDs, so care should be
taken in their storage and handling. The label side is particularly delicate.
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CD-ROM Tracks

CD-ROM tracks are made up of mode1 sectors (type 2, see previous section “About CDs”)
and are used for many file systems such as HFS, ISO 9660 and others.

Disc-At-Once

Disc-at-once is a method of recording CDs whereby the entire CD is recorded in one pass
without turning off the laser. The advantages of disc-at-once are two fold: 

1. No run-out sectors are generated which means that the pause between each track can be
made any length (songs can actually run together). 

2. If you are creating audio CDs to be commercially reproduced, it is normally necessary to
record them in disc-at-once mode as run-out sectors will often be interpreted as
irrecoverable errors. Not all CD-recorders can record in disc-at-once mode.

Disc Images

• they contain all needed data to create a CD (as opposed to virtual images which only
contain references to the data).

• most disc images can be mounted to check contents and functionality (Video CD disc
images cannot be mounted). 

• mounted disc images appear just like any other volume on the desktop. 

• if the disc image was created from a Mac format ("Mac Files & Folders" or "Mac Volume"),
the contents can be modified after mounting (all other disc images appear as a write-
protected volumes)

Enhanced Music CD / CD Extra

CD Extra is the new standard for interactive albums defined in the “blue book”. These discs
consist of two sessions. The first session consists of pure audio tracks, the second session
consists of a data track in a restricted format. If a CD Extra is inserted into an audio CD
player only the audio tracks are visible, the data session cannot be played.

Not all discs containing an audio session and an additional data session are CD Extras! The
data tracks has to contain special information such as MPEG still pictures, etc. Special
software is needed to create a CD Extra file structure or a QuAC file.

Green Book

The Green Book describes the details of the CD-i format (Compact Disc Interactive).

HFS

Hierarchical File System. HFS is the standard Macintosh file system. Because of the Mac’s
ability to use long file names and the unique data fork/resource fork structure of Mac files,
HFS is not conformant to ISO Standard. On a CD recorded in HFS format, each session is
represented as a separate volume on the desktop.

Both "Mac Files & Folders" and "Mac Volume" formats create CDs in the HFS format.
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Index / Index-Point

Every sector contains an index which is a number between 0 and 99. Index 0 and 1 have
special meanings: 0 indicates a pause sector and 1 the beginning of the data in a track.

ISO 9660

ISO 9660 format is a standard for cross-platform CD-ROMs. Discs created in this format can
be read by many different operating systems, including Mac, Windows, DOS, UNIX, etc.

However, since ISO 9660 does not support long file names, custom icons or saved directory
settings (i.e. “view by Icon”), it is less than ideal for discs intended only for Macintosh users.

ISRC-Code

The ISRC-Code holds the "serial number" of each track in a standardized format (as
prescribed by the Red Book.). ISRC codes cannot be set in Toast, Toast CD-DA has to be used
to define these codes.

Media Catalog Number

The Media Catalog Number (MCN) is a unique identification number for the CD (UPC/EAN
Bar-Code). It is issued centrally by the EAN authority and consists of a series of 13
consecutive digits. The MCN can only be defined in Toast CD-DA.

Mixed Mode CD

A mixed mode CD consists of one data track and several audio tracks. Data and audio is
written in one session. The data track is always placed before the audio tracks on the disc and
there is no way to change this order.

The Mixed Mode format has generally been superseded by the audio/data Multisession format
where the first session consists of audio tracks and the second session consists of data (CD
Extra or second session in HFS, ISO 9660 XA, Mac/ISO Hybrid XA format).

MPEG

MPEG is a standardized compression method for audio and video data. Because of its very
high compression rates, MPEG makes it possible to play full screen/full motion video from a
CD. MPEG tracks consist entirely of mode2 form2 sectors and are mostly found on Video CDs
and CD-i discs.

Multisession

A multisession CD consists of multiple sessions, each recorded at a different time. Each of the
sessions are linked together in such a way that only one logical device appears when the CD
is mounted. Not all CD-recorders can record this type of CD and not all CD-ROM drives can
read them.
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Multivolume

A multivolume CD consists of multiple sessions, each recorded at a different time. Each of the
sessions are completely independent of one another so that when the CD is mounted, each 
session appears as an individual logical volume. Not all CD-recorders can record this type of
CD and not all CD-ROM drives can read them. NOTE: HFS CDs can only be multivolume,
not multisession.

Orange Book

The Orange Book is the name of the standard developed by Sony and Philips for recordable
CDs (CD-Rs). Part II of the Orange Book describes the structure of an empty CD-R and the
recording procedure on a physical level.

Pause

A data CD which was recorded in track-at-once mode contains 150 sectors (2 seconds) of
pause and 2 run-out sectors between each track. 

On a mixed-mode CD (data + audio) written in track-at-once mode the gap equals 377 sectors:
375 of pause and 2 run-out sectors. 

A CD with multiple audio tracks written in track-at-once mode has gaps of 150 sectors pause
and 2 run-out sectors. CDs which where recorded in disc-at-once mode do not have a fixed
number of sectors between tracks.

Q-Codes

Q-Codes contain extra information about sectors such as the ISRC code, the Media Catalog
Number and the indices. 

QuAC File

In 1995 Apple introduced the QuickTime Audio Containable standard for documents that
contain information for music CDs as well as pictures and optional interactive controls. QuAC
files can be created with the “Apple Interactive Music Toolkit™” (AIMT).

Red Book

The Red Book is the original CD-DA (Compact Disc Digital Audio) standard developed by
Sony and Philips. The Red Book defines the format in which an audio CD must be recorded
so that an audio CD-player can play it. It also specifies what a CD-player must do to play audio
CDs correctly. A CD recorded in accordance with the Red Book standard will be playable in
every CD-player.

Run-Out Sectors

Run-out sectors are created due to the fact that the write laser beam cannot be turned off
immediately upon termination of data recording. Consequently, 2 sectors are allocated to be
“wasted” as the laser shuts down.
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Scrambling

Data on a CD is scrambled (the bits of data are not recorded one after another in sequential
order; the data is mixed up in a predefined pattern.) The recorder scrambles the data while
writing and the CD player descrambles them when reading. 

Session

A session is a collection of one or more tracks. Each recording procedure generates a session
that contains all the tracks recorded at that time. A CD recorded in multiple recording sessions
is known as a multisession CD.

TOC

The TOC (table-of-contents) contains a list of the contents of a CD. The TOC contains an
entry for each session and each track which lists the index 1 of each track (except CD-i tracks
which have no entry in the TOC). The end or length of the track or session is not recorded in
the TOC.

Track

The track is the smallest logical unit on a CD. A track is a minimum of 600 sectors in length
and a CD can contain up to 99 tracks. There are three types of tracks: audio tracks, CD-ROM
tracks and XA/CD-i tracks. Each track must be preceded by 150 empty sectors. 
A CD recorded in disc-at-once mode requires only the 150 sectors before track 1.

Track-At-Once

The track-at-once mode records each track of a CD individually with 150 empty sectors
immediately preceding it. Run-out sectors are created at the end of each track.

Video CD

VIDEO CD format is used to record full-motion video or movies on a CD. Playing a Video
CD requires special equipment, including an MPEG decoding system.

Use the Video CD format, if you want to write a “white book” compatible Video CD that can
be played on Video CD and CD-i players. A “Video CD” track must always be placed in the
first session of a disc. 

White Book

The White Book describes the data format of a Video CD.

XA / CD-i Tracks

These tracks only contain mode2 sectors and are used for ISO 9660 XA CDs, CD-is, Video
CDs and Photo CDs.
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Yellow Book

The Yellow Book is a document that specifies all parameters for CD-ROMs. The adherence to
these parameters guarantees that the CD can be used on all CD-ROM drives. The Yellow
Book does not however specify the data structures.
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A Toaster’s Checklist
Here are some hints for making your CD mastering work as successful as possible:

• Make sure your recorder is connected properly, using as short a cable as possible.

• Verify that your SCSI chain is correctly terminated.

• Keep the entire SCSI chain as short as possible. 

• If you encounter speed problems, temporarily remove all unneeded SCSI devices
(particularly scanners and SyQuest drives)

• Disable all but essential extensions.

• Check the data transfer rate before writing ("Check Speed", chapter 17).

• Allocate most of your unused RAM to the RAM Cache (Preferences from the Edit menu).

• Before writing with a new system configuration or when writing in a format for the first
time, try writing in Simulation Mode first (see chapter 17).

____________________________________________________________________________

The Optimal System Configuration
There are several factors that effect the hardware requirements for CD recording. In general, if
you want to write at higher speed (2x, 4x, 6x, etc) you will need a faster computer and a faster
hard drive.

We recommend using a Macintosh with 68040 processor or Power Mac with at least 16 MB
of free RAM. (More RAM can help alleviate data transfer irregularities.)

Due to the limited SCSI performance of PowerBook computers, they are not capable of
writing CDs at high speed.

Several of Toast’s features requires SCSI Manager 4.3. Macintoshes which supports the SCSI
Manager 4.3 are capable of significantly higher transfer rates.

You can see if your Macintosh supports SCSI Manager 4.3 by running Toast and looking at
the way your recorder is identified in main window. If "Bus x ID y" is displayed, your
Macintosh supports the SCSI Manager 4.3, if only the SCSI ID is displayed (no Bus), it does
not.

NOTE: 68040 and PowerPC Macintoshes support SCSI Manager 4.3. No PowerBooks
support SCSI Manager 4.3.

Toast requires System 7.0 or above (we recommend using at least System 7.5).
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The extensions "Drag & Drop Manager" and "Thread Manager" have to be installed when
they are not part of the system (like in System 7.5.x). If they are not installed, they will be
added automatically during the installation of Toast. The "Drag & Drop Manager" requires
System 7.1. With System 7.0 you will not be able to drag any items onto the Toast window;
data can only be selected using the dialog boxes.

Steps to Writing a CD

Writing a CD with Toast consists of four basic steps: 

• choosing a CD format, 

• selecting the desired data, 

• verifying that you have sufficient data transfer speed, 

• and clicking the Write CD… button.

In many cases you can simply drag the data you want from the Finder onto the Toast window
to select it. Toast offers many tools for refining your data selection, and for creating complex
CDs in just a few simple steps. For more information, read the section on each format later in
this manual.

IMPORTANT NOTE:

Writing CDs requires a significant amount of computing power. To maximize your success,
we recommend turning off all but essential extensions and control panels when writing CDs.
What is “essential” will vary depending on your application, but generally you can run with
ALL extensions off, except as noted below:

• if you will be copying directly from another CD-ROM drive, you will need to run the
driver software for that CD-ROM drive (for example, an Apple CD-ROM drive uses two
extensions: APPLE CD-ROM and FOREIGN FILE ACCESS).

• if you will be copying from a network volume, you will need your networking drivers.
These may include APPLESHARE, OPEN TRANSPORT, NETWORK, APPLETALK,
TCP/IP, among others.

In addition, to maximize your data transfer rates, you may want to disconnect any extra SCSI
devices. SyQuest drives and scanners in particular have been known to slow down the SCSI
chain (see chapter 17 “The Data Rate”).
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Chapter 3: Mac Volume
____________________________________________________________________________

The MAC VOLUME format is used to write the entire contents of a local volume or partition
to the CD in HFS format.

Areas of Application

Use “Mac Volume” when: 

• You intend to copy an entire volume (hard disk, partition, cartridge, etc. ) to a disc exactly
as it is.

• You want to precisely control the visual appearance of the disc. 

• You intend to publish a disc.

• You want to create a “bootable” CD 

• You want to define a file on the disc that is to be opened automatically when the disc is
inserted.

• You want to optimize the data for faster access.

For detailed information on this format as well as its settings see the section “The Mac Volume
Format” in chapter 16. 

____________________________________________________________________________

Writing a Disc

To write a disc in the Mac Volume format, please proceed as described below: 

1) Prepare your source volume exactly as it should appear on the disc. 

Since an identical copy of your source volume will be created, icons, position and order of
windows and objects etc. are faithfully copied from the source volume to the disc.

If you don’t have a hard disk volume or partition that contains only the data for the CD,
you can use Toast to create a Temporary Partition to hold the data. See “The Utilities
Menu” in chapter 15.
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2) Choose Mac Volume from the Format menu and click Data….

The following window will be displayed:

3) Highlight the desired volume in the upper part of the dialog. 

You can only select volumes with the comment “ok to write”. Depending on the settings
you choose, the comments might change. 

4) Select any additional features using the checkboxes:

a) Optimize on-the-fly to have Toast automatically defragment your data. 

b) Don’t copy free space, if you are not optimizing. 

For detailed information on the various settings see chapter 16 “The Mac Volume Format”.

5) Click OK.

The amount of the selected data and the associated settings will be displayed on the main
window:

6) Choose Check Aliases from the Utilities menu.

Select the desired volume and click OK (see chapter 15 “The Utilities Menu”).

7) Click Check Speed….

Toast will read all the selected data to determine if your system is fast enough to write the
disc in the chosen speed.
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When the test is completed, click Done. 

For more information on the data rate see chapter 17. 

8) Insert a recordable CD in your writer. This disc may be either empty or contain data
that has been written as a session.

To determine if the inserted disc is still recordable, you can choose Disc Info from the
Recorder menu (see also chapter 15, “The Recorder Menu”). 

9) Click Write CD….

The following dialog will be displayed:

10) Verify that the desired writing speed is selected in the pop-up menu.

11) If you may want to add data to this disc later, click Write Session. (If your source volume
contains more than 625 MB this option is disabled. ) 

If you want the disc to be closed so that no further data can be added later, click
Write Disc.

The writing process will begin at the selected speed. When all the data is written, Toast
will automatically verify the data.

For further information on the writing process see chapter 17. 

____________________________________________________________________________

➤➤ You will find the following further information on the format “Mac Volume” in chapter 16:

• Comments 

• The Optimizer

• Don’t copy free space

• Bootable CDs

• AutoStart

• The “Info” dialog

• Check Aliases
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Examples

Example 1: Creating a Disc for Publication

Your Situation and Your Goal:

You want to write a pure Macintosh HFS disc, ready to be duplicated at a disc manufacturing
plant. 
The data includes numerous small files and many customized icons. 
You have a hard disk at your disposal that only contains the data that is to be written. 
You want the disc to hold as much data as possible. 
Your clients’ convenience when using the disc is of highest importance to you. 

Procedure:

1) Prepare the data to be written exactly as you want them to appear on the disc. Since
the appearance of each window is important, open each folder and arrange the files to
your preferred layout (Remember, the disc will keep everything just as you left it, including
view, label settings and icon positions).

2) Open Toast and choose Mac Volume from the Format menu. 

3) Click Data…:

4) Since you are using customized icons for many items and there are a lot of smaller files
on your hard disk, it is very important to optimize the data. 

Check the option Optimize for Size. 

This insures that the icons are displayed rapidly after mounting and that you make the
most efficient use of the space on your disc. Leave the other options unchecked.
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5) Click OK, load the data. 

A figure for the entire amount of data is displayed on the main window, which corresponds
to the figure that is displayed as “Used” in the “Info” dialog. This figure might be bigger
than the free space on your CD-recordable. 

However, since you have selected “Optimize for Size” and your data includes many small
files, this figure will most probably be reduced during optimization.

6) In order to make sure all aliases point to target files that are placed on the same
volume, choose Check Aliases from the Utilities menu.

Select your hard disk to have it checked. (See chapter 15, “The Utilities Menu”).

7) To make sure that the selected amount of data will fit onto your disc after optimizing,
click Check Speed….

Before the data rate is actually checked, the data is prepared for optimization:

➤ Note Once the checking of the data rate has begun, you may cancel the process, since right
now you are just checking the amount of data after optimization (of course, it does not
cause any harm to go through the entire checking routine). 

Click Done to cancel. 

The main window will now indicate how much space your data will actually use on the
CD. If it is still too large for your disc, you will have to delete files from your hard disk
accordingly and repeat the procedure.

8) Check the data rate before writing and write the disc as described in chapter 17. 
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Example 2: Creating a Disc without Optimization

Your Situation and Your Goal:

You want to create a backup of the entire contents of your hard disk. Since the disc will merely
serve as a back up and assuming your Macintosh is not fast enough to optimize while writing,
you write the disc without optimization. Your hard disk has a capacity of 2 GB, but it only
contains 364.3 MB of data:

Procedure:

1) Prepare the data to be written exactly as you want it to appear on the disc.

2) Open Toast and choose Mac Volume from the Format menu. Click Data…:

3) Highlight the name of your hard drive in the upper part of the dialog box. 
Check the option Don’t Copy Free Space. Leave the other options unchecked.

4) Click Info…, to check if the data fits on the disc. The window shows a graphic
representation of the data on your disk.

If you save and delete data frequently on your hard disk, it may appear highly fragmented:
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In this example the hard disk cannot be written to the disc without activating the optimizer,
because the Size of CD-ROM exceeds the capacity of a blank disc. 

Click OK.

➤ Note Toast only recognizes free space after the last data block. (Free space between data blocks
is not recognized.)

If you use NORTON FILE SAVER™, the Size of CD-ROM will always equal the size of the
volume selected, since FILE SAVER stores its invisible files at the very end of the drive.
Deactivate FILE SAVER using its control panel to prevent this.

5) There are two ways to solve this problem: 

a) You can use a standard defragmentation program, e.g. Norton Speed Disk™, to
defragment your hard disk. This rearranges your data in such a manner that it occupies
one continuous block on your hard disk, beginning at the first sector. After
defragmentation the figure for “Used” in “Info” will be equal to the figure for “Size of
CD-ROM”. (See note regarding NORTON FILE SAVER above.)

Defragmentation also speeds up data access on your hard disk. However, the
defragmentation process can take a long time on slow Macs or large hard drives.

After defragmentation return to step 2.

b) If your Macintosh is too slow to optimize data on-the-fly, but you have sufficient free
space, you can have Toast create an optimized duplicate of the data on your hard disk
before writing.

Check the option Optimize for Size.

6) Click OK to close the Data dialog and to select the hard disk. 
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7) Click Write CD….

The following dialog will be displayed:

If you have chosen the second possibility in step 5, i.e. you have enough free space at
your disposal to duplicate your data, check the option Create Disc Image First.

Toast will then save an optimized disc image on your hard disk before writing, which is
then automatically written to the disc. 

8) Click Write Disc or Write Session.

If you have marked the option Create Disc Image First, Toast will ask you where you want
the disc image to be saved (see chapter 17).
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Chapter 4: Mac Files & Folders
____________________________________________________________________________

MAC FILES & FOLDERS is a variation of the HFS format which allows you to select any
combination of files, folders and volumes as the source for your data. It is even possible to
select items from network volumes (depends on network bandwidth).

Areas of Application

Choose “Mac Files & Folders” format: 

• for easy backups

• for rapid data archiving

• if you want to write open files, e.g. the currently used system files on your startup volume

• if you want to control the treatment of aliases. “Mac Files & Folders” allows you to
determine for each alias whether the alias itself or the target file will be written to the CD. 

If you want to prepare a disc for publishing purposes, we strongly recommend using the format
“Mac Volume” (see chapter 4), since “Mac Files & Folders” gives you only limited control
over the layout of your disc (see chapter 16).

For detailed information on this format and on the settings please see the section “The Format
Mac Files & Folders” in chapter 16.

____________________________________________________________________________

Writing a Disc

To use the FILES & FOLDERS format:

1) Start Toast and choose Mac Files & Folders from the Format menu. 

2) Click Data….

The following window will be displayed:
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3) a) Either click Add… and select the desired items:

Click Add until all items are selected. Then click Done.

b) Or drag files and folders that you want to be written to the disc from the Finder
onto the window. (You do not have to select everything at once. Drag as many times
as necessary to include all the desired files.)

29Chapter 4



Depending on what you drag into the empty window, your results will be different:

4) After selecting all your data, click Done. 

The size of the selected data will be displayed in the main window:

➤ Note Toast allows you to save your setup so you can use it later. Simply choose the Save as
command from the File menu.

For further information see chapter 15, “The File Menu”.

5) Click Check Speed….

Toast will read all the selected data to determine if your system is fast enough to write the
disc in the chosen speed.

When the test is completed, click Done. 

For more information on the data rate see chapter 17.

If you drag… Result

one folder This folder will be made into a disc.
Name of the folder  =  Name of the disc
Icon of the folder  =  Icon of the disc
Contents of the folder  =  Contents of the disc

one folder while the A new untitled disc will be created, the folder will 
control button is pressed be placed on the top level in the folder hierarchy.

several folders A new untitled disc will be created, all folders will 
be placed on the top level in the folder hierarchy.

one or several files A new untitled disc will be created, all files are 
placed on the top level in the folder hierarchy.

folders and files A new untitled disc will be created, all objects will 
be placed on the top level in the folder hierarchy.
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6) Insert a recordable CD in your writer. This disc may be either empty or contain data
that has been written as a session.

To determine if the inserted disc is still recordable, you can choose Disc Info from the
Recorder menu (see also chapter 15, “The Recorder Menu”). 

7) Click Write CD…. The following dialog will be displayed:

8) Verify that the desired writing speed is selected in the pop-up menu.

9) If you may want to add data to this disc later, click Write Session. (If your source
volume contains more than 625 MB this option is disabled. ) 

If you want the disc to be closed so that no further data can be added later, click
Write Disc.

The writing process will begin at the selected speed. When all the data is written, Toast
will automatically verify the data.

For further information on the writing process see chapter 17.

____________________________________________________________________________

➤➤ You will find the following further information on the format “Mac Files & Folders” in
chapter 16:

• The Main Window

• Creating a New CD / a New Folder 

• Importing the Data 

• Renaming Folders, Files and the Disc and Changing Visibility 

• About the Desktop Files

• Selecting Items

• Removing Items

• Copying the Contents as Text 
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• Modifying the Hierarchy

• Resolve Aliases

• The Appearance of Windows on the Disc

• The Order of Files on the Disc

• Mac HFS Discs with Several Sessions

____________________________________________________________________________

Examples

Example 1: Backup with Aliases

Your Situation and Your Goal:

You want to create a backup of your clients’ data. In order to make your work easier, you have
created several aliases. This is the folder that is to be backed up:

The folders “John” and “Francis” should be copied exactly as they appear originally.
The folder “Clark” contains aliases that should be loaded in different ways.

- The alias “January” points to another hard disk, that contains already completed projects.
In this case the original should be written instead of the alias.

- The folder “February” should be copied exactly as it is.

- The folder “March” contains references to target files that are located in the folder
“February”. In order not to write those files twice, they should be written as aliases to the
disc.
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Procedure:

1) Choose Mac Files & Folders from the Format menu and click Data…. 

The empty selection window will be displayed. 

2) Click New CD to create an empty disc for your backup. 

3) Change the name of the disc to “Backup”. Double-click the disc icon to open the
information window where you can specify the new name.

4) Click New Folder. Name this folder “Clients A-K”. 

(Note: If all aliases were treated alike, you could drag the original folder “Clients A-K”
onto the selection window.)

5) Drag the two folders “John” and “Francis” over the folder “Clients A-K” you have
just created, since those folders are to be written to the disc without any changes. Since
these folders do not contain any aliases, you need not choose any other settings.

6) Click New Folder. Name this folder “Clark”. 

Drag this folder over the folder “Clients A-K” in order to place it on the same level in the
folder hierarchy as “John” and “Francis”.

7) Check the option Resolve Aliases and drag the alias “January” over the folder “Clark”.

Instead of the alias the original data will now be loaded from the second hard disk.

8) Un-check the option Resolve Aliases (the box next to it is not xed) and drag the two
folders “February” and “March” over the folder “Clark”.

If you look at the contents of the folder “March” (to do this, click on the small arrow icon
so that it points to the bottom), you will see from the italics, that the two aliases “Picture
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DEF” and “Picture XYZ” were loaded instead of the original files.

9) Load all further data for your backup, click Done, check the data rate and write the
disc (see chapter 17).

____________________________________________________________________________

Example 2: Folders with Customized Icons

Your Situation and Your Goal:

You want to create the same backup as in example 1, but you prefer icons other than the
standard icons, both for the disc and the folder “Clients A-K”. However, you cannot change
any icons in Toast itself. 

Procedure:

1) If you create an empty disk as in example 1, you will not have any opportunity to change
the icon later. Therefore, you have to change the icons on the Finder level.

Create a new folder on a hard disk and name it “Backup”. 

2) Copy the icon of your choice for the disc from a suitable source. 

3) Highlight the newly created folder and choose Get Info... from the File menu of the 
Finder.

4) Highlight the icon displayed there by clicking with the mouse and insert the icon by
choosing Paste from the Edit menu of the Finder.
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5) Repeat steps 1) - 4) for the folder “Clients A-K”. 

6) Choose Mac Files & Folders from the Format menu in Toast and click Data….

7) Drag the empty folder “Backup” that contains the icon of your choice onto the
selection window. The folder will be made into the disc. The icon is displayed in this
folder as an invisible file (displayed as a “grayed” icon).

8) Now drag the folder “Clients A-K” onto the disc icon, so that it is placed in the top
level of the folder hierarchy. 

9) Now continue to import your data as described in example 1.
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Example 3: Backup over a Network

Your Situation and Your Goal:

You want to create a backup from various computers in the network. To do so you choose a
time of day when the network will not be busy. 

➤ Note not all networks are fast enough to support direct writing to CD. Be sure to check the speed
before trying to write from the network.

Procedure:

1) Choose Mac Files & Folders from the Format menu and click Data…. 

2) Click New CD and name the disc, e.g. “Backup Jan 20, 96”. 

3) Now mount all the volumes which contain the data to be backed up.

4) Drag the data that is to be written into the selection window in Toast. 

5) When you have selected all the data, click Done. 

➤ Note Since the data has not been loaded from locally mounted volumes, Toast will use the
desktop files of your startup volume for the disc. 

6) Check the speed for all the selected data. To do this click Check Speed….

Go through the entire checking routine! When the selected data is not located on local
volumes, the data rate is extremely important. In case of an insufficient data rate you
could create a disc image before writing (for details on possible problems and solutions
see chapter 17.) 

7) Write the disc as described in chapter 17.
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Chapter 5: ISO 9660
____________________________________________________________________________

The ISO 9660 format is a standard for cross-platform CD-ROMs. Discs created in this format
can be read by many different operating systems, including Mac, DOS, UNIX, etc.

Toast can create standard ISO discs, as well as ISO discs with Joliet extensions which
preserve the long file name structures from Windows95 and WindowsNT. 

Since ISO 9660 does not support custom icons or saved directory settings (i.e. “view by
Icon”), it is less than ideal for discs intended only for Macintosh users.

Note: Toast also supports a special ISO option which preserves Macintosh file names. Disc
written using this option are only useable on Macintosh computers.

Areas of Application

“ISO 9660” format should be used when:

• You want to write a disc that can be run on several platforms, e.g. Windows, Windows 95,
UNIX, Atari, Amiga, Macintosh, etc. 

• You want to write multisession CDs where all sessions are mounted as a single volume (in
contrast to HFS Multivolume where each session appears as a separate volume).

• You prefer incremental backups for your backup purposes, i.e. only the data which has
changed since the last session is written to the disc. Unchanged data is never written to the
disc more than once, saving space and time.

For detailed information on this format as well as its settings see the section “The ISO 9660
Format” in chapter 16.

____________________________________________________________________________

Writing the First ISO Session

To write the first or only session of an ISO 9660 disc, proceed as described below:

1) Choose ISO 9660 from the Format menu. 
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2) Click Data….

The following window will be displayed:

3) a) Either click Add…:

Click Add until all the desired data is selected. Then click Done.

b) Or drag files and folders that you want to be written to the disc from the Finder
onto this window.
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Depending on what you drag onto the empty window, your results will be different:

4) Click the Settings tab at the top edge of the window.

The window changes to the following appearance:

If you drag… Result

one folder This folder will be made into a disc.
Name of the folder  =  Name of the disc
Icon of the folder  =  Icon of the disc

one folder while the A new untitled disc will be created, the folder will 
control button is pressed be placed on the top level in the folder hierarchy.

several folders A new untitled disc will be created, all folders will 
be placed on the top level in the folder hierarchy.

one or several files A new untitled disc will be created, all files are 
placed on the top level in the folder hierarchy.

folders and files A new untitled disc will be created, all objects will 
be placed on the top level in the folder hierarchy.
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5) Select a data format from the Format menu: 

a) Choose the format CD-ROM XA, if you want to be able to add more sessions to this disc
later.

b) Choose the format CD-ROM, if you do not intend to add any more data to the disc later.

6) Choose a Naming option for your files and folders. Toast will automatically convert file
names to conform to the naming option selected.

For details on the various naming possibilities and their implications, see chapter 16, “The
ISO 9660 Format”.

7) Click Done.

The number of files and folders, the size of the selected data, and the space they will
occupy on the disc will be displayed in the main window:

➤ Note Toast allows you to save your setup so you can use it later. Simply choose the Save as
command from the File menu. For further information see chapter 15, “The File Menu”.

8) Click Check Speed….

Toast will read all the selected data to determine if your system is fast enough to write the
disc in the chosen speed.

When the test is completed, click Done. For more information see chapter 17. 
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9) Insert a recordable CD in your writer. This disc may be either empty or contain data
that has been previously written as a session.

To determine if the inserted disc is still recordable, you can choose Disc Info from the
Recorder menu (see also chapter 15, “The Recorder Menu”). 

10) Click Write CD….

The following dialog will be displayed:

11) Verify that the desired writing speed is selected in the pop-up menu.

12) If you may want to add data to this disc later, click Write Session. (If your source
volume contains more than 625 MB this option is disabled.)

If you want the disc to be closed so that no further data can be added later, click
Write Disc.

The writing process will begin at the selected speed. When all the data is written, Toast
will automatically verify the data.

For further information on the writing process see chapter 17.

____________________________________________________________________________

➤➤ You will find the following further information on the format “ISO 9660” in chapter 16:

• Files The Main Window
Creating a New CD / a New Folder
Importing the Data
Renaming Folders, Files and the Disc and Changing Visibility
Selecting Items
Removing Items
Copying the Contents as Text
Modifying the Hierarchy
Resolve Aliases

• Layout The Order of Files on the Disc
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• Settings Format Settings
Naming Settings
Other Settings 

• Concerning Rockridge Extensions for UNIX 

• The Appearance of Windows on the Disc 

____________________________________________________________________________

Writing an Additional ISO Session

This section covers the procedure for adding an additional ISO session to a disc containing
one or more ISO sessions. 

For more details on this procedure see chapter 16, “The ISO 9660 - Multisession Format”. 

If you add a new session to the disc and want to make sure that the data from the previous
sessions is still accessible, follow these steps:

1) Choose ISO 9660 from the Format menu and click Data…. 

2) Drag the data of your choice onto the window. 

For details on the data selection see the previous section, “Writing the First ISO Session”.

3) Click the Settings tab.

Make sure that the format CD-ROM XA is selected and that you select the same naming
option that you used in the previous session.

For information on importing previous sessions from a disc see chapter 16 “The ISO 9660
- Multisession Format”. 

4) Click Done.

The size of the selected data will be displayed in the main window. 

5) Click Check Speed….

When the Data rate has been checked, click Done. 

For more information on the data rate see chapter 17. 

6) Insert the ISO disc to which you want to add the data into your CD recorder. 
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To verify that the inserted disc is really the disc to which you want to add the data, you
can choose Disc Info from the Recorder menu (see also chapter 15, “The Recorder Menu”).

7) Click Write CD….

The following dialog will be displayed:

8) Choose Ignore Existing Sessions, if you do not want previously written sessions visible when
inserting the disc. (it will be as if the data from the old sessions was deleted from the
disc.)

Choose Append to “Name of last session”, if you want all sessions visible when inserting the
disc.

(Incremental Backup is covered in chapter 16, “The ISO 9660 - Multisession Format”.)

9) Click OK.

The following dialog box will be displayed:

10) Click Write Session, if you want to add data to this disc later. 

Click Write Disc, if you want the disc to be closed so that no further data can be added
later.

➤ Note If the setting CD-ROM was chosen for the previous session, you will be unable to add a new
session to the disc!

The writing process will begin at the selected speed. When it is completed, the data will
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be verified automatically. 

For further information on the writing process see chapter 17.

____________________________________________________________________________

➤➤ You will find the following further information on the format “ISO 9600 - Multisession” in
chapter 16: 

• Adding an ISO Session

• Importing a Session from a Disc

• Modifying an Existing File Structure

• Removing an Imported Session
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Examples

Example 1: Daily Backups of a Current Project

Your Situation and Your Goal:

Your are working on a project for client “Smith” and you would like to backup your work
daily. The project is placed in a folder that has the following structure:

You never change the basic structure of this folder. You only add data, or change or delete
existing data.

Since many files do not change every day, you want only new data to be written to the disc in
order to save space and time.

You only want the most recent version of the files to be visible on the disc.

Procedure:

You begin by backing up all the data to a blank disc, then adding the changed data to the same
disc when you backup again.

1) Choose ISO 9600 from the Format menu and click Data…. 

The empty selection window will be displayed. 

2) Drag the folder “Smith” onto the selection window. A new disc is created with the 
folder name “Smith” as its name.

As an example, we will now look at the subfolder “Pictures” of the folder “Ads”:
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This folder contains three pictures “Car boot”, 
“Car driver’s side” and “Logo”.

3) Click Settings.

Choose CD-ROM XA as format and Allow Macintosh Names as naming option. 

Also check Use Apple Extensions. 

➤ Note You can click Set Defaults… to save these settings so you won’t have to reselect them each
time you backup.

4) Click Done.

The size of the selected data will be displayed in the main window. 

5) Click Check Speed…, to check the transfer rate. 

For details see chapter 17.

6) Click Write CD… and then Write Session. 

All the selected data will be written to the disc. 

When finished, the data in our example would look something like this:
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When you are ready to back-up the changed data. 

1) Again, choose ISO 9660 and click Data….

2) Drag the same folder “Smith” onto the selection window. These are the differences:

The file “Logo” was deleted, the file “Logo new” was
added. 

The picture “Car front side” was added. 

3) Verify that you have selected CD-ROM XA as format, Macintosh Names as naming option
and that Apple Extensions are activated, then click Done.

4) Click Write CD….

The following dialog will be displayed:

5) Check the option Incremental Backup and click OK. 

Toast will now check which files were changed, deleted, or added. After checking, only
the size of the data that is actually to be written is displayed in MB in the main window. 

6) Click Write Session in the next dialog. 

Only the changed data will be written to the disc. 

After writing, the folder “Pictures” will look like this:
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the picture “Logo” is not
visible any more, because it
was deleted from the source
folder.

➤ Note if any files have exactly the same name, the same modification date and are placed in the
same file structure as in the previous session, they will not be written to the disc again.

____________________________________________________________________________

Example 2: Specific Rearrangement of Old Sessions

Your Situation and Your Goal:

At the conclusion of your project “Smith” (as described above), you obtain a hard disk from
your client that contains further data. You want to write this data to your disc without saving it
on your hard disk first. Your client’s hard disk contains a folder with new pictures. You want
to arrange these pictures on the disc so that they appear in the appropriate existing folders.

As an example, we will again look at the subfolder “Pictures” of the folder “Ads”.

Procedure:

1) Start Toast and insert the disc with the project “Smith” in the recorder. 

2) Choose ISO 9660 from the Format menu and click Data…. 

The empty selection window will be displayed. 

3) Select Import Session… from the pop-up menu in the window.

Toast will read all sessions of the inserted disc and display them in a window:
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4) Highlight the last session (it contains the newest data), select Merged and click OK. 

The entire file structure of the imported session will now be displayed in the selection
window:

The files that are marked with a disc icon have already
been written to the disc (all files in this case).

5) Click New Folder.

A new folder will be created on the top level in the folder hierarchy. 

6) Double-click the new folder.

The following window will be displayed:

Name the folder “Originals” and click OK.
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7) Drag the new folder over the subfolder “Pictures” of the folder “Ads”.

8) Now drag all the pictures of your choice from you client’s hard disk over the folder
“Originals” and click Done (this example assumes that you have already defined the
correct settings for format and naming option as default in example 1).

9) Check the transfer rate and click Write CD… (see chapter 17). 

10) Click Write Disc in the dialog now displayed, because the project is to be concluded
with this session.

Toast will only write the new data that you have selected. The file structure and the data
of the last imported session will be retained. 

After writing, the disc would look like this:
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Example 3: Placing old Sessions in a Folder

Your Situation and Your Goal:

You are beginning a new project for your client Smith. You want to keep all the files from the
old project, but you want them marked as “old projects”.

Procedure:

1) Start Toast and insert the disc with the old projects in your recorder. 

2) Choose ISO 9660 from the Format menu and click Data…. 

3) Click New CD and name it “Smith projects”. 

4) Drag the files and folders from the new project onto the window. 

They will appear at the top level of the folder hierarchy.

5) Choose Import Session from the pop-up menu in the window.

Toast will read and display the contents of the disc. 

6) Highlight the last session (it contains all the data) and choose the option Put into a
directory. Click OK.

The previous session will be appear as a folder on the top level in the folder hierarchy.
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7) Change the name of the folder which contains the old session to “Smith old” and
click Done.

This part was newly loaded.

This part has already been written to the disc.

8) Check the data transfer rate and write the disc (see chapter 17).

When finished, the disc would look something like this:

The folder “Smith old” contains the data from previous sessions, while the folder 
“Mailing February” contains the new project.
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Chapter 6: Mac/ISO Hybrid
____________________________________________________________________________

The HYBRID format combines both ISO 9660 and HFS format on a single disc. This allows
Macintosh users to see the normal icons and window positions for the data, while maintaining
complete compatibility with DOS/Windows systems (and others).

Areas of Application

HYBRID format should be used when:

You want to write discs that can be read on a Macintosh and on a PC, with the Macintosh data
only visible to the Macintosh users and the ISO data only visible to other users.

Hybrid format is ideal for: 

- Multimedia applications intended for both Macintosh and DOS/Windows

- Writing picture, sound or text files that can be read on both platforms

- Software created for both platforms that you want to deliver on a single disc

- As the second session of an audio CD, so that the audio tracks are only shown on an
Audio CD player and the computer data only on a computer (many people mistake this for
CD Extra).

For detailed information on this format as well as its settings see the section “Mac/ISO Hybrid
format” in chapter 16. 

____________________________________________________________________________

Writing the Disc

A disc can contain only one Hybrid session. This session can be written as a first session or as
the second session of an audio CD. 

A Mac/ISO Hybrid disc uses two data sources: a Macintosh volume and a group of
files/folders which are selected to be the ISO data.
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a) Preparing the Data for the Macintosh Part of the Disc

The Macintosh part of the Hybrid disc must be created from a Macintosh volume (hard disk,
temporary partition, hard partition, etc.).

This volume should contain:

• Files and folders that will only be visible on the Macintosh and

• Files and folders that will be visible to both the Macintosh and ISO users. This is
referred to as the “shared data” (these files will only be written to the disc once). 

For information on the creation of a temporary partition see chapter 15, “The Utilities Menu”.

➤ Note The Macintosh volume will be copied exactly to the disc, including window sizes, positions and
view settings. If the arrangement of the windows is important to you, be sure to prepare the
volume accordingly. 

b) Preparing the Data for the ISO Part of the Disc

Generally, no special preparation is needed for the ISO part, since you can choose files and
folders one by one for writing. However, if you intend to prepare the disc for publishing, we
recommend to collect the ISO data in a folder. This will help you to avoid mistakes and also
makes the data selection a lot easier. The determination of which data is shared occurs while
selecting the ISO data (see below). 

c) Selecting the Macintosh Data

To select the Macintosh data for the Hybrid disc: 

1) Choose Mac/ISO Hybrid from the Format menu.

2) Click Mac….

The following window will be displayed:
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3) Highlight the volume of your choice in the upper part of the window. 

You should check Optimize to avoid problems relating to sector sizes and to make the disc
as responsive as possible. Click OK. 

The size of the selected data will be displayed in the main window.

For information on the various settings see chapter 16, “The Mac Volume Format”.

d) Selecting the exclusive ISO Data

To select the exclusive ISO data for the Hybrid disc: 

1) Click ISO….

An empty selection window will be displayed:
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2) Drag the ISO data onto the selection window or click Add…. 

Any files that are not placed on the selected Macintosh volume will be displayed in black
print.

e) Selecting the Shared Data

Now drag any shared data from the Macintosh volume selected in step “C” to the desired
location in the ISO file structure or click Add… to select them. 

Files and folders may have different names in the Mac and in the ISO part.

Shared files are displayed in blue (only the files, not the folders). These files will be written to
the disc only once but will be visible by both Mac and PC users.

f) Settings

Click the Settings tab. The following window will be displayed:

• Choose the format CD-ROM XA, if the Hybrid session will be the second session of an
audio CD.

• Choose CD-ROM, if this is to be the only session on the disc.

Choose a Naming option for files and folders. 

For details on the various settings see chapter 16, “The ISO 9660 Format”.
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g) Writing a Disc

1) When you have selected all the data and chosen the correct settings, click Done.

The selected data will be displayed in the main window:

➤ Note Toast allows you to save your setup so you can use it later. Simply choose the Save as
command from the File menu. 
For further information see chapter 15, “The File Menu”.

2) Click Check Speed….

Toast will read all the selected data to determine if your system is fast enough to write the
disc in the chosen speed.

When the test is completed, click Done. 

For more information on the data rate see chapter 17. 

3) Insert a recordable CD in your writer.

4) Click Write CD….

The following dialog will be displayed:

5) Verify that the desired writing speed is selected in the pop-up menu.

6) Click Write Disc (writing a session is not recommended for Hybrid discs).

The writing process will begin at the selected speed. 
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When all the data is written, Toast will automatically verify the data.

For further information on the writing process see chapter 17.

____________________________________________________________________________

➤➤ You will find further information on the Macintosh part of the Hybrid disc in chapter 16,
“The Mac Volume Format”

You will find further information on the ISO part of a Hybrid disc in chapter 16, “The ISO
9660 Format”.

You will find the following further information that concerns only Hybrid discs in chapter
16, “The Mac/ISO Hybrid Format”:

• Preparing the Mac Portion of a Hybrid Disc

• About Block Size and Shared Data

• The ISO Part of a Hybrid Disc

• Why Multisession Hybrid Disc are a Bad Idea 

• Testing your Hybrid Disc before Writing

____________________________________________________________________________

Examples

Example 1: Creating a Disc for Publication

Your Situation and Your Goal:

You want to write a Hybrid disc that will be submitted for manufacturing. You have created a
multimedia application which has different applications (executables) for Macintosh and PC
but which uses the same supporting data files.

For the Macintosh part you have a hard disk at you disposal that contains all the Macintosh
data together with the shared data. You have arranged the hard disk so that the main window
is open and only the executable application is visible:

The multimedia application for the 
Macintosh on a Macintosh volume.
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For the ISO part you have created a folder on another hard disk, that contains data that will
be visible only to PC users:

The data for the PC

The folder “DOS” is empty at the
moment, it will later contain the shared
data.

➤ Note It is no longer necessary to create aliases for shared data (as required in older versions of
Toast), however this method will still work. Toast realizes if an alias points to a target file on the
selected Macintosh volume and will write this file only once (if Resolve aliases is checked).

With some authoring applications it may cause problems if you use different names for shared
data on the Macintosh and PC sides. We recommend your using names of the format 8.3
characters for all shared files. (Check with the publisher of your authoring applications for
information on handling shared data files.)

For details on restrictions for the naming options see chapter 16, “The ISO 9660 Format”.

Procedure:

1) Choose Mac/ISO Hybrid from the Format menu. 

2) Click Mac….

Highlight the hard disk that contains the Macintosh data and the shared data. Since you
intend to publish the disc, you want the data arrangement on the disc to be as perfect as
possible. Therefore, check the option Optimize. Do not check the other options. Click OK.

If your system configuration is not fast enough to optimize on-the-fly, you can save a disc
image of all the data before writing (see below). 

3) Click ISO….

The empty selection window will be displayed. 

4) Drag the folder containing the ISO data onto the window. 

All these files belong exclusively to the ISO part, so all file names are displayed in black:
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The folder “DOS” is still empty.

5) In the Finder highlight the files on the selected Macintosh volume that are to be shared
by the Macintosh and ISO parts of the disc.

6) Drag these files onto the folder “DOS” in the ISO window. 

The shared files will be displayed in blue:

All files in the folder “DOS” will be shared, since they
have already been selected as part of the Mac volume.

7) Click Settings and choose the following options: 

• Format: CD-ROM

• Naming: Allow MS-DOS Names

• Append Version numbers: not checked

• Use Apple extensions: not checked
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8) Click OK.

The size of the selected data will be displayed in the main window:

9) Click Check Speed….

Before the checking routine begins, the optimization process will be prepared:

After this, the speed check routine will start. Be sure to allow the check to finish if you
are unsure whether your system is fast enough to optimize on-the-fly. Click Done. 

10) Click Write CD….

If the result of the speed check was negative, check the option Create Disc Image First and
click OK. (If a disc image is created, you will be asked to specify a location for storing the
image file). 

The writing process will start automatically after saving.

____________________________________________________________________________

Example 2: Creating a Disc that Only Contains Shared Data

Your Situation and Your Goal:

You want to create a disc that contains graphics and text files. Since you do not know whether
the disc will be used on a Mac or a PC, you decide to write a Hybrid disc. (You could also use
the pure ISO 9660 format, but it does not allow control over the placement and appearance of
files like HFS does.)

You have collected all the data in a folder, rather than having it on a volume which contains
no other data. Consequently, you will create a temporary partition for the Macintosh part and
copy the data into it.
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Procedure:

We will explain the procedure in detail. If you already know how to create a temporary
partition, you can skip to step “b”. 

a) Creating a Temporary Partition

1) Make sure that you have a hard disk connected with enough free space to duplicate
all the data to be written. 

2) Choose Create Temporary Partition from the Utilities menu. 

The following window will be displayed:

3) Enter a size for the partition that is about 2 MB larger than the data to be copied.
(You can use the GET INFO command in the Finder to determine the size of the
data.)

Select a volume that contains sufficient free space and click OK. 

The temporary partition will be created. A single file (the “image file”) the size of the
partition will be created on the volume you selected; the partition itself will be mounted
on the desktop. 

For details on temporary partitions see chapter 15, “The Utilities Menu”. 

4) Copy the contents of your folder into the mounted partition by dragging it onto the
icon of the mounted partition (not the icon of the image file). 

Arrange the data as you would like it to appear on the finished disc:
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➤ Note If you have chosen a custom font for displaying file names (using the VIEWS control panel), it is
a good idea to reset the font to the default setting of “9 pt Geneva” before arranging the icons.
This will help insure that the windows look the way you intended when viewed on another
Macintosh.

b) Selecting the Data for the Macintosh Part

1) Choose Mac/ISO Hybrid from the Format menu and click Mac…. 

The Mac Volume selection window will be displayed:

2) Highlight the temporary partition and check the option Optimize. Click OK.

c) Selecting the Data for the ISO Part

1) Click ISO….

The empty selection window will be displayed. 

2) Drag the same partition onto the window that you have selected for the Macintosh
part.

All the data will be recognized as shared and will be written to the disc only once.

3) Click the Settings tab.

Select Joliet (MS-DOS + Windows95) from the naming menu

4) Click Done.

The size of the data selected will be displayed in the main window.
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6) Check the data rate and write the disc. 

See chapter 17.
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Chapter 7: Audio CD
____________________________________________________________________________

The AUDIO CD format records audio tracks on the CD in the format used by standard
consumer CD players.

Areas of Application

Use the “Audio CD” format if you want to write a standard audio CD. The discs can be played
on all audio CD players, as long as the audio data is placed in the first session of the disc. 

➤ Stop Never write an audio session as second the session of a disc, since standard CD players can
only read the first session.

For detailed information on this format as well as its settings see the section “The Audio CD
Format” in chapter 16.

____________________________________________________________________________

Introduction to Toast’s Greatest Hits

Toast’s Greatest Hits is a great new feature that lets you create audio CDs by simply dragging
tracks from existing CDs or sound files onto the Toast track list. 

• Tracks can be copied directly from the original CD without having to save them to a hard
drive first. You can even select tracks from different CDs and Toast will prompt you to insert
the correct source CD while writing the new disc.

• Toast can also write audio CDs from standard Mac sound files. Toast recognizes
SoundDesigner II or AIFF sound files (they must be in 16-bit, 44.1 kHz format)

You can combine these two methods if desired.

Note: direct copying of audio tracks requires a CD-ROM drive which supports audio
extraction and a Macintosh which supports SCSI Manager 4.3.
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Writing an Audio CD

1) Choose Audio CD from the Format menu. 

2) Click Audio….

The Audio Tracks window will be displayed:

3) Drag the audio files or tracks that are to be written to the disc from the Finder onto
the window:

or click Add… and select the desired files. 
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The selected items will be displayed in the Audio Tracks window. You can click and drag
on items in the list to rearrange them.

NOTE: Toast uses the disc and track names which have been entered with the AppleCD
Audio Player. If the selected tracks have already been named, the names will appear in
the track list.

If you select a track belonging to a CD which has not been named, Toast will prompt you
to give the CD a name:

You can also specify names for each track. Names entered in Toast are saved in the same
database used by the AppleCD Audio Player.

Double-click on any item in the track list to display the naming dialog:

Enter the desired track name(s) then click OK. You can use the arrows to move to a
different track. If you change the name of a track which is based on a sound file, rather
than a CD track, the name of the source file will be changed. 

Toast automatically inserts a 2 second gap between each track. If desired, you can
specify a different gap using the Pause menu. The menu will set the pause before the
selected track(s).
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If your recorder does not support pauses of less than two seconds, you may see this
message:

Check the Toast READ ME file on the installation disc for more information.

4) When all files are loaded, click DONE.

The total length of the selected tracks will be displayed in the main window:

5) Click Check Speed….

Toast will read all the selected tracks to determine if your system is fast enough to write
the disc in the chosen speed.

If you have selected tracks from more than on CD, Toast will prompt you to insert
the appropriate disc as it reads each track:

When the test is completed, click Done. 

For more information on the data rate see chapter 17. 
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6) Insert a blank recordable CD in your writer.

In order to check if the inserted disc is indeed empty, choose Disc Info from the Recorder
menu (see also chapter 15, “The Recorder Menu”).

7) Click Write CD….

If you have selected tracks from more than one disc, Toast will display a list of the discs
you will need:

Make sure you have all the required source discs, then click OK. This window will be
displayed:

8) Verify that the desired writing speed is selected in the pop-up menu.
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9) If you want to add data to this disc later, click Write Session. (If your audio files occupy
more than 625 MB or if you selected 99 files this option is disabled.)

Note: standard audio players can only read tracks from the first session!

If you want the disc to be closed so that no further data can be added later, click
Write Disc.

The writing process will begin at the selected speed. 

Toast will prompt you to insert the appropriate source disc as it reads each track:

NOTE: Audio files cannot be verified after writing. 

For further information on the writing process see chapter 17.

➤➤ You will find the following further information on the format “Audio CD” in chapter 16:

• Naming audio CDs and tracks

• Selecting Audio Files in Toast

• Rearranging the Audio Files 

• Saving Audio tracks as sound files

• Removing Audio Files

• Previewing Audio Files 

• Index-Points – Text and Numeric Markers

• The Pause between Tracks
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Chapter 8: CD-i
____________________________________________________________________________

The CD-i (compact disc interactive) format is designed primarily for multimedia applications
and games. CD-i discs require special playback equipment.

Areas of Application and Requirements

Use the CD-i format, if you want to write a disc that can be played on CD-i players.

In order to be able to write a CD-i, you need a completely mastered CD-i disc image that
contains the entire data and target files. Such images can be created with a CD-i authoring
system like MediaMogul. You can also load CD-i disc images that were created with
“ASTARTE CD-Copy” from an existing CD-i. You cannot create CD-i links with Toast, or
import “dyuv” files or videos into Toast.

For detailed information on this format see the section “The CD-i Format” in chapter 16.

____________________________________________________________________________

Writing a CD-i

1) Choose CD-i from the Format menu and click Data…. 

The standard file selection dialog will be displayed:

2) Select the desired CD-i image and click Open. 

Or drag the disc image onto the main window.
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The size of the selected data will be displayed in the main window:

3) Click Check Speed….

Toast will read the selected data to determine if your system is fast enough to write the
disc in the chosen speed.

When the test is completed, click Done. For more information on the data rate see chapter 17.

4) Insert a blank recordable in your CD recorder. 

In order to check if the inserted disc is indeed empty, choose Disc Info from the Recorder
menu (see also chapter 15, “The Recorder Menu”).

5) Click Write CD….

The following dialog will be displayed:

6) If you want to add data to this disc later, click Write Session. (THIS IS NOT
RECOMMENDED FOR CD-i FORMAT!).

If you want the disc to be closed so that no further data can be added later, click
Write Disc.

The writing process will be started in the selected speed. 

CD-i data cannot be verified after writing. For further information on the writing process
see chapter 17.

➤➤ You will find the following further information on the format “CD-i” in c chapter 16:

• Scrambling
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Chapter 9: Video CD
____________________________________________________________________________

The VIDEO CD format is used to record full-motion video or movies on a CD. Playing a
Video CD requires special equipment, including an MPEG decoding system.

Areas of Application and Requirements

Use the Video CD format, if you want to write a “white book” compatible Video CD that can
be played on Video CD and CD-i players. A “Video CD” track must always be placed in the
first session of a disc. 

To write a “Video CD”, you need the following data:

• a Video CD disc image, that contains the MPEG-stream(s), menu pages, and links (this
file is created by a Video CD authoring systems) or

• MPEG streams that were created with “ASTARTE M. Pack” (version 1.02 or later).

You have to use the following settings for encoding and multiplexing in “ASTARTE M.
Pack”:

- Basic Settings: Format ➔ Custom; Target System ➔ Video CD

- Video: Format ➔ PAL or NTSC

- Audio: Bit Rate ➔ 224 KBit/s

- Multiplex: Toast-Ready ➔ checked.

Video CDs created directly from M.Pack MPEG streams will not have menus; they simply
play their video tracks in the order they were added to the list.

For detailed information on this format please see the section “The Video CD Format” in
chapter 16.

____________________________________________________________________________

Writing a Video CD

1) Choose Video CD from the Format menu and click Data…. 
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The following dialog box will be displayed:

2) Choose one of the two possibilities:

a) A Video CD image file.

The standard file selector dialog, from which you can choose a disc image, will be 
displayed.

b) One or more MPEG streams.

The following window will be displayed:

Enter the name for the disc, drag the MPEG-streams of your choice onto the window
(or use the Add… button) and click OK.
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3) The loaded data will be displayed in the main window: 

a) If you have loaded a disc image:

b) If you have loaded MPEG streams:

4) Click Check Speed….

Toast will read all the selected data to determine if your system is fast enough to write the
disc in the chosen speed.

When the test is completed, click Done. 

For more information on the data rate see chapter 17.

5) Insert a recordable CD in your writer.

6) Click Write CD….

The following dialog will be displayed:

7) Verify that the desired writing speed is selected in the pop-up menu.
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8) If you want to add data to this disc later, click Write Session. 
(THIS IS NOT RECOMMENDED for VideoCD format!)

If you want the disc to be closed so that no further data can be added later, click
Write Disc.

The writing process will begin at the selected speed. 

Video CD data cannot be verified after writing.

For further information on the writing process see chapter 17.

____________________________________________________________________________

➤➤ You will find the following further information on the format “Video CD” in chapter 16:

• A Video CD from a Disc Image 

• A Video CD from MPEG Streams 

• Adding MPEG Tracks to a Video CD 

• Changing the Order of the Tracks

• Removing MPEG Tracks from the List
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Chapter 10: Enhanced Music CD
____________________________________________________________________________

The ENHANCED CD (CD EXTRA, formerly known as CD PLUS) format combines audio
tracks and graphic files on a disc that can be played using special applications which allow
you to view the graphics while hearing the sound.

➤ Note Creation of Enhanced Music CDs can be quite complex. This section is intended only as an
overview of the process. We recommend that you refer to the documentation included with
your Enhanced Music CD authoring system for more information.

Areas of Application and Requirements

Use the format “Enhanced Music CD” (or “CD Extra”, formerly “CD Plus”), if you want to
write a “blue book” compatible disc. An “Enhanced Music CD” track always occupies the
second session of an audio CD. 

In order to write an Enhanced CD, you have to create the associated file/folder structure as it
is defined in the “blue book”, or you need a corresponding QuAC file created with the “Apple
Interactive Music Toolkit™” (AIMT).

In the past an Enhanced CD was often misunderstood to be simply a disc that contained one
audio session and any other data session (in HFS, ISO 9660 XA or Hybrid XA format) as its
second session. Such discs do not actually comply with the “blue book” standard. If you are
not concerned with compliance to the standard, you can write a second session using the
techniques discussed in chapter 3 through 6.

A CD EXTRA disc written with Toast is always written as a Hybrid disc with shared data for
the Macintosh and the PC.

For detailed information on this format please see the section “The Enhanced Music CD
Format” in chapter 16.

____________________________________________________________________________

Writing an Enhanced Music CD

Start with a CD which already has audio tracks written as its first session (see chapter 7 for
more information).
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1) Copy the QuAC file onto a Macintosh volume. (If the volume already contains data,
this data will also be visible on the Macintosh part of the disc)
or

Create a CD EXTRA directory structure on a Macintosh volume. 

For details on QuAC files and CD Extra directory structures see Chapter 16 “The
Enhanced Music CD Format”.

2) Choose Enhanced Music CD from the Format menu and click Data…. 

The following dialog will be displayed:

3) Highlight the volume that contains the required file structure or the QuAC file.

Toast will verify that the volume contains the required data structure for an Enhanced CD.
If the structure does not conform to the “blue book” specifications, Toast will report which
files or other elements are missing.

The selected data will be displayed:

If there was a QuAC file on the volume, Toast generates a CD EXTRA directory structure
based on its contents. A new folder named “CD EXTRA” is then placed on the volume. 

4) The folder “CD EXTRA” contains all the data which will be “shared” (visible on both
the Mac and ISO parts of the disc). Although this data will be visible on both the Macintosh
and on the PC it will only be written once to the disc.

Drag any additional files that you want into the “CD EXTRA” folder. 

80 Enhanced Music CD: Example



➤ Note Toast uses the MS-DOS naming conventions for the ISO part of this Hybrid disc. Make sure
all your files and folders conform to the 8-dot-3 naming format.

You can also drag aliases which point to items located on the same Mac volume onto the
“CD EXTRA” folder. This allows to have shared data placed in different directory structures
on the Macintosh and on the PC.

5) Click Check Speed….

Toast will read all the selected data to determine if your system is fast enough to write the
disc in the chosen speed.

When the test is completed, click Done. 

For more information on the data rate see chapter 17.

6) Insert your disc which already contains the audio session in your CD recorder.

In order to check if the inserted disc contains an audio session, you can choose Disc Info
from the Recorder menu (see also chapter 15, “The Recorder Menu”).

7) Click Write CD….

The following dialog will be displayed:

8) If you want to add data to this disc later, click Write Session
(THIS IS NOT RECOMMENDED for this format!). 

If you want the disc to be closed so that no further data can be added later, click
Write Disc. 

The writing process will begin at the selected speed. 

Enhanced Music CD data cannot be verified after writing. 

For further information on the writing process see chapter 17.
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➤➤ You will find the following further information on the format “Enhanced Music CD” in
chapter 16:

• Steps to Creating an Enhanced Music CD

• QuAC Files

• CD EXTRA Hierarchies

____________________________________________________________________________

Example: Creating a CD EXTRA with Additional
Data for Macintosh and PC

Your Situation and Your Goal:

You wish to produce an audio CD with additional computer data. The disc should conform to
the “blue book” specification in order to be authorized to have the “CD EXTRA” label. You
created a QuAC file with the software “Apple Interactive Music Toolkit™”. This QuAC file
contains all desired information about the audio tracks on the disc.

For marketing purposes you want to put an additional multimedia presentation on the disc
which describes your company. This presentation was created with the authoring tool
“Macromedia Director™”. You have created different applications (executables) for
Macintosh and PC but you want to share the supporting data files (Director™ documents and
QuickTime™ movies).

Procedure:

1) Write all audio tracks on a blank CD-R. Be sure to choose the option Write Session,
not Write Disc.

For more control over pauses, ISRC codes and MCN you could use the optional software
“Toast CD-DA” for mastering the audio session. 

2) Prepare a Macintosh volume which only contains the following data:

• the QuAC file,

• the Director™ application for the Mac and

• all Director™ documents and videos, which are
accessed by the Mac and the PC application (in a
folder named “DOCS”). 
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3) Choose Enhanced Music CD from the Format menu. Click Data….

Select the volume, check Optimize and
click OK.

4) The following dialog is displayed:

If there were more than one QuAC file on the volume you could now select the correct
one. In this example there is only one QuAC file on the volume. Click Yes.

5) Go back to the Finder and see how the volume has changed:

Toast created a “CD EXTRA” folder out of the QuAC file which contains the directory
structure defined in the “blue book”.

6) The folder “CD EXTRA” is shared, i.e. it contains all the data which will be visible
on the Macintosh and on the PC. All other items are only visible on the Macintosh.

To make the multimedia application visible on the PC, copy the PC executable and other
files which are needed on the PC into the folder “CD EXTRA”.

Then create an alias of the folder “DOCS” (it contains all Director™ documents and
QuickTime™ movies which are to be shared) and drag this alias onto the folder “CD
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EXTRA” (don’t forget to change the name of the alias so that the PC application can find
the folder and the contained files).

7) Go back to Toast, check the data rate and write the disc (see chapter 17).

The integrity of the directory structure will be checked again before writing.
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Chapter 11: SCSI Copy
____________________________________________________________________________

SCSI COPY lets you copy directly from one SCSI device (such as a CD-ROM drive) to a CD.

Areas of Application and Requirements

Use the “SCSI Copy” format, if you want to create the exact copy of a SCSI device, e.g. hard
disks, CD-ROM  drives with a disc inserted, magneto-optical drives with a cartridge inserted,
ZIP drives with a disk inserted, etc.

You have to observe the following restrictions: 

• Since SCSI copy makes an exact copy of the volume, the resulting CD may not work as
expected. For example, if you copy a volume which has been formatted as a DOS drive, it
will not work properly on a PC; PCs require the ISO format for CDs, but your CD would
have the format and structure of a hard disk.

• You can faithfully copy and read Macintosh hard disk in this manner, however we
recommend using the “Mac Volume” format instead.

• If you select an audio disc or a mixed mode disc, Toast will use SCSI Copy for the data
part of the disc and the Audio Tracks option for the audio tracks. This will be set up
automatically.

• You cannot copy discs that contain Mode2 Form2 sectors (“Terminology” in chapter 2)
e.g. Video CDs, CD-i, Photo CDs, etc., because the Macintosh cannot read those sectors.

• Discs to be copied must only contain one session, because the Macintosh cannot read the
sectors between sessions.

• To copy discs with multiple sessions, you could use an application like “ASTARTE CD-
Copy” which will save the contents of the disc as files which can then be written back to
the disc with Toast.

For detailed information on SCSI Copy and its settings please see the section “The SCSI
Copy Format” in chapter 16.

____________________________________________________________________________

Writing a SCSI Copy

1) Choose SCSI Copy from the Format menu and click Data…. 

All connected SCSI devices will be displayed:
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2) Select the device to be copied and click OK. 

The following dialog box will be displayed:

When you select a CD that you have written yourself, Toast will automatically subtract the
unreadable blocks at the end of the disc to avoid errors while writing.

Do not change these numbers unless you know what you are doing, or you disc may not
work. 

3) Click OK.

The amount of data to be written will be displayed in the main window:
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4) Click Check Speed….

Toast will read all the selected data to determine if your system is fast enough to write the
disc in the chosen speed.

➤ Note If you are copying from a CD, make sure that the speed of the CD-ROM drive is higher than
the selected writing speed. As a general rule, use a write speed that is 1/2 the speed of the
reader.

When the test is completed, click Done. 

For more information on the data rate see chapter 17.

5) Insert a blank recordable in your CD recorder. 

To verify that the inserted disc is indeed empty, you can choose Disc Info from the Recorder
menu (see also chapter 15, “The Recorder Menu”). 

6) Click Write CD….

The following dialog will be displayed:

7) If you want to add data to this disc later, click Write Session. 
(THIS IS NOT RECOMMENDED!) 

If you want the disc to be closed so that no further data can be added later, click
Write Disc.

The writing process will begin at the selected speed. 

For further information on the writing process see chapter 17.

____________________________________________________________________________

➤➤ You will find the following further information on the format “SCSI Copy” in chapter 16:

• Searching the SCSI Bus

• Options

• The Amount of Data to be Copied

87Chapter 11



• When Copying a CD

Examples

Example 1: Copying a Large Volume Using SCSI Copy

Your Situation and Your Goal:

You want to copy a 2 GB hard disk which contains almost 600 MB of data. The drive has
been defragmented.
You have verified that the target system can read the file system of your hard disk if it’s 
recorded on a CD.

Procedure:

1) Choose SCSI Copy from the Format menu and click Data…. 

The SCSI selection window will be displayed:

In this example, the hard disk we want is connected to bus 0, SCSI ID 6. 

Notice that the entire hard disk is too large to be copied to a disc.

2) Select the hard disk and click OK. 

3) Enter 600 MB into the dialog displayed. The copy can start at sector 0, since the hard
disk was defragmented:
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➤ Note Toast will only copy the data in the range you have entered. If there is data on the disc,
outside of that range, it will not be copied, and most likely the disc will not work.

4) Click OK.

The amount of the selected data will be displayed in the main window:

5) Check the data rate and write the disc. 

See chapter 17.

____________________________________________________________________________

Example 2: Creating a Backup of a CD-ROM that You Have
Written Yourself

Your Situation and Your Goal:

You have written a disc in Hybrid format that is to be submitted for manufacturing. You want
to create a backup disc for safety. You have at least one 2x CD-ROM drive at you disposal, so
you can be sure that the speed will suffice to copy directly from disc to disc (2x readers can
usually be copied at 1x, while a 4x reader can usually be copied at 2x). 

Procedure:

1) Insert the CD-ROM in your CD-ROM drive. 
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2) Choose SCSI Copy from the Format menu and click Data….

The CD-ROM drive is connected on bus 0 with SCSI ID 3:

3) Select the appropriate drive from the list and click OK.

The number of blocks on the disc does not correspond with the number of blocks to be
copied, since a disc that you have written yourself always contains “run out” sectors at the
end, that cannot be read by the Macintosh (see the section “Terminology in chapter 2),
Toast automatically excludes these blocks to avoid errors while writing.

4) Click OK, check the data rate and write the disc. 

See chapter 17.
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Chapter 12: Disc Image
____________________________________________________________________________

Areas of Application

The Disc Image format allows you to write a previously created disc image to a CD. You can
use disc images created by Toast, as well as images generated by a variety of specialized tools.

A disc image is simply a single file, saved on your drive, that contains ALL the data and
formatting information needed to create the CD.

You would use Disc Image format under these circumstances:

• if you have saved your selected data as a disc image in Toast (see chapter 15 “The File
Menu”).

• you need to write an image to disc but don’t know its exact format.

• If you used a UNIX utility (like “mkisofs”) to create an ISO image with Rockridge
extensions. (see chapter 16 “The ISO 9660 Format”), 

• after saving the contents of an HFS, ISO 9660, Hybrid disc or other single-track CD-
ROMs with “ASTARTE CD-Copy”.

➤ Stop When saving the contents of a Photo CD with “ASTARTE CD-Copy” the “Multitrack CD-ROM
XA” format must be used, not the Disc Image format (see next chapter).

For detailed information about this format please see chapter 16 “The Disc Image Format”.

____________________________________________________________________________

Writing a Disc Image to CD

1) Select Disc Image from the Format menu and Click Data….

The standard file selection dialog will be displayed:

91Chapter 12



2) Select the desired disc image and click Open.

The size and format of the selected data will be indicated in the main window:

3) Click Check Speed….

Toast will read all the selected data to determine if your system is fast enough to write the
disc in the chosen speed.

When the test is completed, click Done. 

For more information on the data rate see chapter 17.

4) Insert a recordable CD in your writer. 

To determine if the inserted disc is still recordable, you can choose Disc Info from the
Recorder menu (see also chapter 15, “The Recorder Menu”). 

5) Click Write CD…. The following dialog will be displayed:
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6) Verify that the desired writing speed is selected in the pop-up menu.

7) If you may want to add data to this disc later, click Write Session. (If your source
volume contains more than 625 MB this option is disabled. ) 

If you want the disc to be closed so that no further data can be added later, click
Write Disc.

The writing process will begin at the selected speed. When all the data is written, Toast
will automatically verify the data.

For further information on the writing process see chapter 17.

____________________________________________________________________________

➤➤ You will find the following further information on the format “Disc Image” in chapter 16:

• Auto-Detect Format

• Mounting Disc Images

____________________________________________________________________________

Example: 

Creating, Mounting and Writing a Disc Image

Your Situation and Your Goal: 

After finishing a multimedia production in Hybrid Format you want to test the applications
before actually writing the discs.

Procedure:

Begin by setting up your Hybrid disc, including selecting the Hybrid format and selecting the
appropriate data for the Mac and ISO parts of the disc. (following the instructions in chapter 6)

1) Select Save as Disc Image… from the File menu..

A dialog is displayed.

2) Select a hard disk with enough free space to hold the disc image file (check the Toast
main window for details on how much disk space will be required.)
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A progress indicator will be displayed while Toast builds the image file.

3) When the process is complete, double-click the saved disc image.

Toast will automatically switch to the Disc Image format and select the newly created image
as the source.

4) Click the Mount button.

Since you’ve created a Hybrid disc, two volumes will be mounted on the desktop: one for
the Mac part and one for the ISO part. 

You can now test items on the disc (Hybrid images are mounted as read-only so no
changes can be made to the data.)

5) Once you are satisfied that everything is set up correctly, you can write the disc (see
chapter 17).
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Chapter 13: Multitrack CD-ROM XA
____________________________________________________________________________

Areas of Application

The Multitrack CD-ROM XA format is used to write a disc with several CD-ROM XA tracks
in one session.

➤ Note This format is seldom used, as most CD formats consist of only one data track per session. Its
most common use is for copying Photo CDs with a tool like “ASTARTE CD-Copy”. 

For detailed information about this format see chapter 16 “The Multitrack CD-ROM XA
Format”.

____________________________________________________________________________

Writing a Disc with Several XA Tracks

1) Select Multitrack CD-ROM XA from the Format menu. Click Data….

The CD-ROM XA dialog will be displayed:

2) Click Add… and select the desired CD-ROM XA files or drag the files into the window.

The Names, Sizes and Block Sizes of the selected files will be displayed. You may drag
the items around in the list to change their order, if desired.

3) After selecting all files click OK.
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The total size of the selected tracks will be displayed in the main window:

4) Click Check Speed….

Toast will read all the selected data to determine if your system is fast enough to write the
disc in the chosen speed.

When the test is completed, click Done. 

For more information on the data rate see chapter 17.

5) Insert a recordable CD in your writer. 

To determine if the inserted disc is still recordable, you can choose Disc Info from the
Recorder menu (see also chapter 15, “The Recorder Menu”). 

6) Click Write CD…. The following dialog will be displayed:

7) Verify that the desired writing speed is selected in the pop-up menu.

8) If you may want to add data to this disc later, click Write Session. (If your source
volume contains more than 625 MB this option is disabled. ) 

If you want the disc to be closed so that no further data can be added later, click
Write Disc.

The writing process will begin at the selected speed.

For further information on the writing process see chapter 17.
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Chapter 14: Audio Tracks – Mixed Mode CD
____________________________________________________________________________

Areas of Application & Requirements

The Mixed-Mode format is used to combine one data track and several audio tracks in a
single session.

This format has been largely replaced by “CD-Extra” (see chapter 10).

• The data portion of a Mixed Mode CD can be any of the Toast formats. 

• The audio tracks can be set up using the normal techniques outlined in Chapter 16.

____________________________________________________________________________

Writing a Mixed Mode CD

1) Select the desired data format from the Format menu, and select Audio Tracks from the
Format menu.

Two buttons are displayed in the main window: Data… and Audio…. 

2) Click Data….

Select your data. For details see the respective chapter on the selected data format.

3) Click Audio….

The audio track selection window is displayed:
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4) Click Add… and select the desired audio files or drag the audio files into the window.

File name, Time and number of index-points in the track selection window. 

5) After selecting all the desired audio files click OK.

The total size of the selected tracks (data and audio) will be displayed in the main window:

6) Click Check Speed….

Toast will read all the selected data to determine if your system is fast enough to write the
disc in the chosen speed.

When the test is completed, click Done. 

For more information on the data rate see chapter 17.

7) Insert a blank recordable CD in your writer. 

To determine if the inserted disc is indeed blank, you can choose Disc Info from the
Recorder menu (see also chapter 15, “The Recorder Menu”). 

8) Click Write CD…. The following dialog will be displayed:
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9) Verify that the desired writing speed is selected in the pop-up menu.

10) If you may want to add data to this disc later, click Write Session. (If your source
volume contains more than 625 MB this option is disabled. ) 

If you want the disc to be closed so that no further data can be added later, click
Write Disc.

The writing process will begin at the selected speed. The audio tracks cannot be verified
after writing.

For further information on the writing process see chapter 17.
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Chapter 15: The Menus
____________________________________________________________________________

The File Menu

The File menu consists of the following items:

Open
Opens previously saved Toast files (or virtual images), which restores all the settings and file
selections to the same state as when it was saved.

Save / Save as
Saves a virtual image containing references to all selected data, settings, modified file names
so they can be restored later.

Virtual images can be created for every format. 

Toast will generally ask if you want to save your current settings when you quit the application
or switch to a different format.

➤ Note Since a virtual image saves references to selected files, but not the files themselves, the image
will be invalid if the original data is deleted.

Revert
Revert to last saved Toast document (virtual image).
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Save as Disc Image
Saves all selected data as a single file. This file contains all the data for the CD, not just the
settings.

Disc Images can be written to a CD at any time, even if the original data has been moved or
deleted.

There are several situations where you might want to create a disc image:

• if your Mac is too slow to write or optimize on-the-fly.

• if you are writing data from a network volume or CD that doesn’t have sufficient speed to
write directly.

• if you want another person to write the discs, but don’t want them to be able to change the
contents or layout of the disc.

Properties of disc images:

• they contain all needed data (as opposed to virtual images which only contain references
to the data).

• most disc images can be mounted to check contents and functionality (Video CD disc
images cannot be mounted). 

• mounted disc images appear just like any other volume on the desktop. 

• if the disc image was created from a Mac format ("Mac Files & Folders" or "Mac Volume"),
the contents can be modified after mounting (all other disc images appear as a write-
protected volumes)

Mounting a disc image:

• Select Mount Disc Image from the Utilities menu.

➤ Note Only defragmented disc images can be mounted (the entire image file must reside on contiguous
blocks on your hard disk). Use a commercial disk optimizer like Norton Speed Disk™ to
defragment if necessary.

To save a disc image and write the CD all in one step select the option Create Disc Image first
after clicking Write CD… on the main screen (see chapter 17).

Quit
Exits the Toast application, after asking you to save your settings (when appropriate).

➤ Note Clicking the Close box in the main window is the same as selecting the Quit command.
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The Edit Menu

The Edit menu consists of the following items:

Standard Functions

Undo, Cut, Copy, Paste, Clear and Select All are standard Macintosh functions that are available
for use in any of Toast’s lists or error logs.

The Copy function can also be used to copy all selected items as text in the “ISO 9660” and
the “Mac Files & Folders” dialog (see chapter 16 for details).

Preferences
Displays a dialog box which allows you to set the following operational parameters:

Disk Cache

In addition to the RAM cache, Toast uses your hard disk to temporarily store small files while
optimizing and writing on-the-fly. 
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If you have more than one hard disk attached to your Mac, you can specify which drive to use
for this temporary storage:

Select the fastest drive that has sufficient free space. 

➤ Note Don’t select an optical drive or other slow storage devices as the Disk Cache.

RAM Cache

Toast uses RAM installed in your Macintosh to augment the RAM cache built into your
recorder. 

The amount of RAM Toast uses for Cache Enhancement is selectable:

You can choose a relative amount, based on the 
selected write speed, or 

you can set a specific amount of RAM to be used,
regardless of the write speed.

In general, if you are writing CDs from data sources with erratic data rates (like network
volumes), you should set a higher value. On the other hand, if you generally write from a very
fast hard drive on a fast computer, small values should work just fine.

➤ Note Cache Enhancement only works if your Mac supports SCSI Manager 4.3 and if you have 
asynchronous hard disk drivers installed.

Preferred Drive for Reading Audio

If you have more than one CD-ROM drive on your system, you can use this menu to specify
which drive will be ejected when Toast requests an audio disc. 

The TEST button will check the selected drive to verify that it has audio extraction
capabilities. This test requires an audio disc in the drive.
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Calculate a checksum while verifying

When this option is checked, Toast will calculate a checksum each time it verifies a disc. This
is useful if you are writing CDs from image files created in another application that also
calculates a checksum (such as Astarte CD-Copy). You could then compare the two values to
insure that the disc is identical to its source.

Once it is calculated, you can select Copy to copy the Checksum to the clipboard.

➤ Note if you don't have software that generates images and checksums, don’t bother to check this
option.

The Format Menu

The Format menu is used to select the specific CD format that you want to write. Each format
is explained in detail in Part 2 and chapter 16.

➤ Note You can also switch formats using the popup menu on the main screen:

____________________________________________________________________________
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The Recorder Menu

The Recorder menu contains commands related to the functioning of the CD recorder.

Write Speed
Allows you to specify what speed to use when writing a CD. Only the speeds that are
applicable to your recorder will be available in the menu.

➤ Note You can also set the write speed in the write dialog after clicking Write CD… (see chapter 17).

Simulation Mode
Selecting Simulation Mode allows you to test the entire writing process without actually
writing any data to your blank CD. This is a very accurate way to insure that you have
sufficient data transfer rate before writing a CD.

The words ***Simulation Mode*** are displayed in the menubar in red while Simulation
Mode is active.

➤ Note When you write a CD using Simulation Mode, it will look just like the disc is actually being written.
The record light on the CD writer will even turn on. But as long as SIMULATION MODE appears
in the menubar, no data will be written to the disc.

Simulation Mode can also be set in the write dialog after clicking Write CD… (see chapter 17).

108 The Utilities Menu



Disc Info
Select this command to view information about the CD currently inserted in the recorder:

Available information includes:

- Media type (recordable or not)

- any existing sessions that may be on the
disc

- amount of disc space used and available

- whether the disc can accept additional
sessions

109Chapter 15



Recorder Info
This command displays technical information about the connected CD recorder. If you ever
need to know the firmware version of your recorder, you can find it by using this command.

Eject
Ejects any currently inserted CD from the recorder.

Mount CD-ROM
This will cause any mountable sessions that may be on the currently inserted disc to appear on
the Mac desktop. Once a disc is mounted, it can be used normally until you eject the disc or
restart the computer, even if you exit the Toast application.

It is not necessary for the Toast CD Reader extension to be installed for this function to work. 

➤ Stop Blank CD-Rs cannot be mounted.
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The Utilities Menu

The Utilities menu consists of the following items:

Mount Disc Image
Mounts a previously created disc image on the Mac desktop. All images except Video CD
images can be mounted.

Mounted images function just like any other volume.

Mounted HFS Images can be modified, all other formats are mounted as “read only”.

➤ Note Only defragmented disc images can be mounted (the entire image file must reside on
contiguous blocks on your hard disc). Use a commercial disc optimizer like Norton Speed Disk
to defragment if necessary.

Images can also be mounted by clicking Mount on the main screen in the “Disc Image” Format
(see chapter 16).

Create Temporary Partition
This command allows you to create an empty disk image file of any size which can then be
mounted and used to set up data to be written to a CD.

Temporary partitions are useful in situations where you want to have complete control over
the layout of your data and how its windows are arranged and displayed.

Since temporary partitions are automatically created with 2K allocation blocks, they can also
make it possible to have shared data on a hybrid CD, even though your hard drive may not
have the required block size. (See chapter 6 for more information on shared data.)

Follow these steps to create a temporary partition:
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1) Select Create Temporary Partition.

2) Enter Name and desired Size for the partition.

3) Select the hard disk where you want the image file for this partition to reside.

4) Click OK.

➤ Stop Temporary partition files must reside on contiguous blocks on your hard disc. 

If sufficient contiguous space is not available, Toast will report an error:

Compare
The Compare command is used to compare the contents of two data sets to see if they match.
You can compare two volumes, two folders, or two files:
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➤ Note Compare differs from the Verification function which Toast performs after writing a CD in two 
significant ways. First, Verify always compares the selected source data to the finished CD;
with Compare you can compare any two data sets. Second, Compare checks each individual file
when comparing the data; the Verify function only compares blocks. This means that when the
Compare function finds a problem, it can usually tell you exactly which file contains the error.

1) Choose Volumes, Folders or Files from the pop-up menu.

2) Select the desired original and copy.

3) Click Compare.

If any mismatches are found, Toast will display a list:

You can select items from the list and simply drag them to the desktop to create a text-clip
file (requires the Apple Clipping extension). Open the clip by double-clicking its icon.
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Check Aliases
Examines all the aliases on a specified volume to make sure they all point to items on the
same volume and that all the original files can be found.

You should always check aliases before writing in Mac Volume or Hybrid format.

After choosing Check Aliases, select the desired volume and click OK.

Aliases are checked, and any problems are displayed in a list:

You can drag items from the list to the Finder for later use:

Be sure to delete or correct any non-functional aliases before writing your CD.

114 The Utilities Menu



Make System 6 Compatible
Choosing this command causes Toast to build a System 6-type desktop file on the selected
volume that will be written on the CD. This is required if the disc will be used on Macs
running System 6.

Select the desired volume and click OK. 

The desktop file is created on the volume.

Autoloader
To automatically write a series of discs, select this item. After writing one disc Toast waits for
a new discs to be inserted and starts writing when the recorder is ready. 

• Use Autoloader: Check this option to use the Autoloader option.

• Type: Select the desired Autoloader type. To use this function even if you have no
autoloader system select the Generic option. You can then insert a new disc yourself as
soon as one disc is finished. If you want to write several discs with the same contents, this
function is very useful to save time and avoid errors.

• Stop on error: Checking this option causes Toast to stop writing any additional discs if it
encounters an error while writing or verifying. We recommend always using this option.

• Write log file: Select this command to have Toast keep a log file of all events during a 
writing session.

• Verification: The Verify command lets you specify which discs should be verified while
writing multiple discs with an autoloader system. 
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➤ Note Verifying takes as long as writing (see chapter 18). To minimize the time it takes to verify,
uncheck the option Calculate a checksum while verifying in the Preferences (Edit menu).

After clicking Write CD… on the main window the following dialog will be displayed:

Enter the number of copies to be written.

If you want the discs to be closed so that no further data can be added later, check the option
Fixate Discs. 

After clicking Start the following dialog is displayed:
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Chapter 16: Settings for the different 
Formats

____________________________________________________________________________

The “Mac Volume” Format

The volume selection window is displayed after clicking Data…:

This window lists all available volumes/partitions along with information about their status.

Comments

Only volumes which are listed as ok to write can be selected as the data source for a Mac
Volume CD.

Other possible comments are listed here, along with suggestions for correcting problems.

Comment Information Possible Solutions

Startup volume This volume contains the Check “Optimize on-the-fly”.
active System Folder Open files can then be written.

Busy This volume contains the Check “Optimize on-the-fly”.
currently used Toast Open files can then be written.
software.
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The Optimizer

Background

The built-in optimizer is one of Toast’s most useful features. Its unique technology allows you
to do things that used to be impossible:

• you can now reliably write a CD from a fragmented data source

• you can write CDs that seem to hold more data, by allowing Toast to select the optimum
block size

• you can write CDs that mount more quickly and feel more responsive, by having Toast
position every file at the beginning of a sector.

• any mounted volume can be selected as your data source, even the startup volume and
volumes with files in use.

• you can change your data right up to the time you write the CD, without having to worry
about creating fragmentation (as would be the case if you used normal optimizers.)

Functionality of the Optimizer

Unlike typical disc optimizers, Toast’s optimizer works while the disc is being written.

• Nothing is changed on the source volume, so there is no risk to your data.

• The directory and desktop files for the CD are written at the beginning of the disc, greatly
reducing seek time for finished disc, and further increasing responsiveness.

Comment Information Possible Solutions

Shared The volume is currently Turn off Filesharing in the
being shared. Sharing Setup control panel

Audio CD, The volume is not an Write the volume using SCSI Copy,
ISO 9660, HFS volume. or use another software tools to
High Sierra, convert the contents into writable
MFS format (e.g. "ASTARTE CD-

Copy").

Foreign The volume is not an HFS Select the data in “Mac Files &
File System volume, it is e.g a DOS Folders” or in “ISO 9660” format.

formatted hard disk.

Server Volume The volume is a server Select the data in “Mac Files &
volume. Folders” format.
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The Optimizer’s Settings

You can choose between two different optimizer strategies: 

• Optimize For Size

• Optimize For Speed

➤ Note All Mac volumes are divided into allocation blocks. A volume can have a maximum of 65,535
blocks, no matter how large the volume is. Since a file always occupies at least one block, the
larger the volume is, the larger the minimum size of the file on the disc (due to the increased
block size). 

The option Optimize for Size looks for the smallest possible block size and uses it for the CD.
This means that if you have many small files, you might be able to save more data onto a disc
than without optimizing.

The option Optimize for Speed looks for the smallest possible block size which is a multiple of
2048. This insures that each file starts at the beginning of a CD sector (1 CD sector = 2048
bytes), which speeds up access times. (When writing a Mac/ISO Hybrid disc this option is the
only available as the ISO 9660 system is based on CD sectors.)

An extreme example:
You have 20,000 files, all smaller than 512 bytes. 

Using for Size a block size of 512 bytes is used, the volume needs : 512 * 20,000 = 10 MB. 

Using for Speed a block size of 2048 bytes is used, the volume needs: 2048 * 20,000 = 40 MB.

Other Advantages of the Optimizer

• Even if your system configuration is not fast enough to optimize on-the-fly you still save
time when saving the volume as disc image and you get a disc which is optimized for CD
and not for hard disk

• Finished discs will have no errors in their file structure as the optimizer creates a fresh
structure as it works. You might even be able to write from a volume which has a damaged
file structure.

Disadvantages of the Optimizer

• Higher hardware requirements: Power Mac or 68040 with 25 MHz, SCSI Manager 4.3
support and a fast hard disk.

• The optimizer requires more available RAM: about 1 MB for each 3000 files, plus 4 MB
for 2x write speed, 6 MB for 4x write speed.

Both issues can be resolved by saving the volume as disc image before writing (see chapter 15
“The File Menu”).
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Don’t copy free space

➤ Note if you select one of the optimization methods, then this option is not available (or needed).

Selecting Don’t copy free space causes Toast to ignore any portion of the source volume after
the last block which contains data.

This option allows you to use a source volume which is larger than the capacity of the CD, as
long as the defragmented data does not use more space than the CD has available.

➤ Stop Your data should be defragmented for this option to be useful; empty blocks that are “buried”
among the used blocks are not considered to be free. (see "The Info Dialog" below)

Bootable CDs

Select the Bootable option to create a CD which can function as a startup disc when used in an
Apple-brand SCSI CD-ROM drive. 

In order for the bootable option to work, the source volume must contain a functional System
Folder that will work on the specific Macintosh model(s) that you want to use the disc in. A
System Folder that works on one Mac (a PowerMac for example) will not necessarily work
properly on a different Mac model. Be sure you construct a System Folder that is appropriate
for the target machine(s).

➤ Stop A Trash and a Desktop-Folder are created as soon as you click this option; this can be annoying
if the finished disc will be shared over a network; do not select the bootable option if you don’t
need it.

To actually boot from a bootable CD, you have to press a special key code while the Macintosh
starts up:

• on some Macs, you simply press and hold the “c” key until the “Welcome To Macintosh”
message appears.

• on other models, you have to press and hold the Command, Option, Shift and Delete keys
(simultaneously) until the message appears.

• You can also use the STARTUP DISK control panel to set the CD as the startup device.

AutoStart

Using the AutoStart option, you can specify a file/application that will open automatically 
whenever the CD is mounted.

• When you click the Autostart option, a standard file selection window appears. Simply 
select the desired file and click Open.

• To change the selected file, click on its name in the rectangle. The selection window is
then again displayed.
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➤ Stop The name of the item selected must be 11 characters or less, and the file must reside at the
root level of the drive. 

If you select a file (rather than an application) to Autorun, be sure that the application needed to
open that file will be available on the target system.

The “Info” Dialog

Once you’ve selected a volume in the volume selection window, the Info… button will be
available. Click the button to display this informational window:

The upper portion of the window shows a graphic representation of the data on your disk. The
blue areas show blocks which contain data, while gray areas show empty blocks. (If you save
and delete data frequently on your hard disk, it may appear highly fragmented, with many gray
areas “buried” within the blue area.)

➤ Note Toast only recognizes free space after the last data block. (Free space between data blocks is
not recognized.)
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If you use NORTON FILE SAVER, the Size of CD-ROM will always equal the size of the volume
selected, since FILE SAVER stores its invisible files at the very end of the drive. Deactivate FILE
SAVER using its control panel to prevent this.

The items in the lower left part of the window display details about the volume you’ve selected,
including the total size of the volume and its block size, along with the amount of space used
by files, and the amount of free space. 

To the right of the volume information is the Size of CD-ROM info. This number shows how
much space is required on the CD to be able to write all the data from the selected volume. 
If the volume is fragmented, the space required will be larger than the actual space used (as
shown to the left). 

➤ Note When Optimize on-the-fly is checked, the information shown in this window may not be
accurate. 

Check Aliases

Before writing a Mac Volume, it’s a good idea to use the Check Aliases command to insure that
any aliases on the CD will function as expected. (See chapter 15 "The Utilities Menu".)
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The “Mac Files & Folders” Format

The Main Window
The main file selection window lists all the files and folders that you have selected for inclusion
on your CD. Changes that you make in this window will change the contents of the CD.

All directories are displayed in alphabetical order. The list behaves very much like a standard
directory window in the Finder which is sorted “by name”.

Click on the arrow to the left of the disc or folder name to “open” the item and display its
contents. Click the arrow again to “close” the item.

➤ Note To open all folders at once hold the Option-key while clicking an arrow. Repeat the procedure
to close all folders.

Creating a New CD / a New Folder

If the selection window is empty, you can create a new CD by clicking the New CD button.

An untitled CD icon will appear in the list. You can then add other items to the CD by dragging
and dropping, or by using the Add… button.

If the selection window already contains some items, the New Folder button will be available.
Click it to create a new, empty folder at the same level as any selected item. If no item is
selected when you click the New Folder button, the new folder will be placed at the root level.

Importing the Data

1) Drag & Drop Method

To add files and/or folders to the list, simply select their icons in the Finder and drag them
onto the Toast window.
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2) The Selection Method

Click the Add… button.

Select the desired item from the file selection dialog and click Add. Repeat as often as
required to add all the items you want.

Click Done when finished.

Renaming Folders, Files and the Disc & Changing Visibility
You can change the name of files, folders and discs, as well as setting their visibility property
without affecting the original items on your drive.

To change the name of an item in the list, double-click it.

The information window is displayed:

Enter the new name and click OK.

To make a file or a folder invisible check the Invisible checkbox. When checked, the item will
be written to the CD, but will not be visible in the Finder.
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Invisible items are displayed in gray in the list.

➤ Note Two desktop files are always written onto each CD – "Desktop DB" and "Desktop DF" (see
below). These files are always invisible, regardless of how you set their “Invisible” property.

About the Desktop Files
The Desktop files contain information that the Mac operating system uses to determine which
icon should be associated with each file or folder. Normally, each Mac volume has its own
desktop files. These files are updated automatically by the System, whenever you copy new
items to that volume.

Because Toast makes it possible to assemble a CD from files and folders located on several
different volumes, it is possible that the desktop files may not contain all the icons needed to
properly display each item. Toast attempts to use the desktop files that will yield the best
result, but in some cases you may want to override its choices.

Here is how Toast gets its desktop file information:

If a folder is dragged from a local volume into the empty window, the desktop files of the
volume where that folder resides are selected. If you start by selecting a folder from a non-
local volume, the desktop files of the startup volume are used.

To select the desktop files of a special volume, start with an empty Toast window and import
any folder (it can even be empty) from that volume. Toast will then use the desktop files from
that volume.

Selecting Items
To select a single item in the list, simply click on it. To select more than one item, use one of
these methods:
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• Drag a selection-rectangle around the items with the mouse. 

• Click the first item, hold down the shift-key and select the last item to select all items
in between.

• To select items which are not next to each other in the list, hold down the command-
key while clicking the respective items.

• To select all items in the list choose Select All in the Edit menu.

Removing Items

To remove selected items use the Backspace key, choose Clear from the Edit menu or click the
Remove button.

➤ Stop Removing items cannot be undone. If you accidentally remove the wrong item you will have to
reselect it.

Copying the Contents as Text

To copy the contents of the list as text select Copy from the Edit menu. The text can be pasted
into any other application.

Modifying the Hierarchy
You can reorganize the hierarchy of the CD by dragging items around in the list. You can move
items to different folders or move folders until you have the layout you want.
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➤ Stop If you change the contents of a folder by moving items in the Toast file selection window, then
its appearance will no longer match the original when written to the disc. (see below "The
Appearance of Windows on the Disc")

Resolve Aliases
If the data you select for your disc contains aliases, you can determine how those aliases are
treated when the CD is written.

Resolve Aliases checked ➔ the original files will be written onto your CD
Resolve Aliases not checked ➔ the aliases will be written to the CD

➤ Stop If you decided not to resolve aliases, you should make sure that the aliases will still be valid
once they are written to the disc. 

➤➤ Also see chapter 4 Example 1: "Backup with Aliases".

The Appearance of Windows on the Disc
If the contents of an imported folder is not changed by any means, the appearance of the
window will be exactly the same as in the original folder (this includes the view settings,
window size, and window position).

If items are added to a folder which were not in the original folder, the contents will be
displayed according to these rules:

• If the folder contains 9 items or less its contents will be sorted “by icon”. (If you use long
file names, they may overlap when viewed this way.)
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• If a folder contains more than 9 items it will be sorted “by name”.

The Order of Files on the Disc
Files/folders are written onto the disc in alphabetical order, as shown here:

1
2
3

4
5
6

7
8

9

Data is written defragmented to leave the maximum amount of free space for additional 
sessions.

Mac HFS Discs with Several Sessions
An HFS disc with more than one session is a multi-volume disc. This means that each session
will always appear as a separate volume on your desktop.

Depending on which CD-ROM driver you use, you may initially only see the first session
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when you insert a multi-volume disc in your CD-ROM drive. 

• Apple CD-ROM driver Version 5.0.x and lower: 

Only the first session is automatically mounted.

• Apple CD-ROM driver Version 5.1.1 and higher:

All sessions are automatically mounted as separate volumes on the desktop.

• Toast CD-Reader Version 2.0 and higher (to use your recorder as a player):

All sessions are automatically mounted as separate volumes on the desktop.
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The “ISO 9660” Format
The ISO File Selection window has three parts: Files, Layout and Settings. You can switch
between the parts by clicking the tabs at the top of the window:

• Files: selecting the data

• Layout: determining the layout or order of the files on the disc

• Settings: setting the options for file naming, format, etc.

Files 

The Main Window
The main file selection window lists all the files and folders that you have selected for inclusion
on your CD. Changes that you make in this window will change the contents of the CD.

All directories are displayed in alphabetical order. The list behaves very much like a standard
directory window in the Finder which is sorted “by name”.

Click on the arrow to the left of the disc or folder name to “open” the item and display its
contents. Click the arrow again to “close” the item.

➤ Note To open all folders at once hold the Option-key while clicking an arrow. Repeat the procedure
to close all folders.

Creating a New CD / a New Folder

If the selection window is empty, you can create a new CD by clicking the New CD button. An
untitled CD icon will appear in the list. You can then add other items to the CD by dragging
and dropping, or by using the Add… button.
If the selection window already contains some items, the New Folder button will be available.
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Click it to create a new, empty folder at the same level as any selected item. If no item is
selected when you click the New Folder button, the new folder will be placed at the root level.

Importing the Data

1) Drag & Drop Method

To add files and/or folders to the list, simply select their icons in the Finder and drag them
onto the Toast window.

2) The Selection Method

Click the Add… button.

Select the desired item from the file selection dialog and click Add. Repeat as often as
required to add all the items you want.

Click Done when finished.
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Renaming Folders, Files and the Disc & Changing Visibility
You can change the name of files, folders and discs, as well as setting their visibility property
without affecting the original items on your drive.

To change the name of an item in the list, double-click it.

The information window is displayed:

Enter the new name and click OK. 

To make a file or a folder invisible check the Invisible checkbox. When checked, the item will
be written to the CD, but will not be visible in the Finder.

Invisible items are displayed in gray in the list:
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Selecting Items
To select a single item in the list, simply click on it.

To select more than one item, use one of these methods:

• Drag a selection-rectangle around the items with the mouse. 

• Click the first item, hold down the shift-key and select the last item to select all items
in between.

• To select items which are not next to each other in the list, hold down the command-
key while clicking the respective items.

• To select all items in the list choose Select All in the Edit menu.

Removing Items

To remove selected items use the Backspace key, choose Clear from the Edit menu or click the
Remove button.

➤ Stop Removing items can not be undone. If you accidentally remove the wrong item you will have to
reselect it.
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Copying the Contents as Text

To copy the contents of the list as text select Copy from the Edit menu.Depending on the
naming option selected, one of these windows will be displayed: 

• All items: all items in the selection window are copied as text.

• Renamed items or Items with Illegal Names: only renamed or illegal items are copied as text.
For details on the different naming options please see “Settings” below.

The text can be pasted into any other application.

Modifying the Hierarchy
You can reorganize the hierarchy of the CD by dragging items around in the list. You can
move items to different folders or move folders until you have the layout you want.

Resolve Aliases
If the data you select for your disc contains aliases, you can determine how those aliases are
treated when the CD is written.

Resolve Aliases checked ➔ the original files will be written onto your CD
Resolve Aliases not checked ➔ the aliases will be written to the CD.

➤ Stop Aliases only work on Macintoshes; if the ISO disc you are creating will be used on other
systems BE SURE TO SELECT RESOLVE ALIASES so the original items will copied to the
CD!

➤ Note If you are working on a hybrid disc, aliases which point to items on the selected Mac volume
will be resolved by using shared data.
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Layout

The Order of Files on the Disc

If no changes are made in the Layout portion of the files selection window, then the files are
written in the following order:

1
2
3

4
5
6

7
8

9

Files are written defragmented to leave the most possible space for more sessions.

In most cases the standard layout will work just fine.

However, you can change the order in which the files are written on the disc for special 
purposes.

To change the order, simply move selected files to the desired place in the list.

• Files located at the top of the list will be written first (towards the inner part of the disc).

• To place selected files on top or at the bottom click Move to top or Move to bottom
respectively.
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➤ Note You can move more than one item at a time. See above for information on selecting files in
the list.

Settings

Format Settings

Use the Format pop-up menu to select the desired format for your ISO disc.

CD-ROM

This format should be used for single session CDs, and CDs that will be duplicated by a 
replication plant. Some very old CD-ROM drives can only read CDs in this format.

➤ Note If you select CD-ROM format, you will not be able to add sessions to the disc later.

CD-ROM XA

Select CD-ROM XA format for multisession discs, so you have the possibility of adding 
additional sessions later.

➤ Stop When a Hybrid track is written as a second session of an audio CD this format has to be used.
See chapter 6 and below for details.

Electronic Book

The Electronic Book format is rarely used. You will know if you need it.

Naming Settings

The Naming menu lets you specify how Toast should handle file names that are not compatible
with the ISO file format.
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Toast will automatically transform file or folder names so they conform to the selected naming
option.

The Files list displays the transformed name, along with the original name (in gray).

➤ Note To see all transformed (or illegal) names choose Copy in the Edit menu, then select All items or
Renamed items (or illegal names) from the dialog that appears. You can then paste the list into any
text processing application.

ISO 9660 Level 1

This is the original ISO naming format and is very restrictive (most systems don’t need pure
ISO standard).

Name requirements:

• Length: 8.3 characters

• Characters: uppercase letters A-Z, numbers 0-9 and the underscore _. No other characters
are allowed.

• Examples: ISO_NAME.TXT, IMAGE_1.TIF

ISO Level 1 has a limitation of 8 levels of nested directories. Toast will allow you to have
more than 8 levels but the data might not be readable on many systems (you will be warned
before trying to write an ISO disc with more than 8 levels).

Allow MS-DOS Names

Similar to ISO Level 1 but not as restrictive. Use this option for discs intended for DOS or
Windows 3.x systems.

• Length: 8.3 characters

• Characters: uppercase letters A-Z, numbers 0-9, the underscore _ and these special
characters:{ } @ - ^ ! $ % & ( ) ` ´ # ~ 
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ISO format has a limitation of 8 levels of nested directories. Toast will allow you to have
more than 8 levels but the data might not be readable on many systems (you will be warned
before trying to write an ISO disc with more than 8 levels).

Allow Macintosh Names

This option causes Toast to leave all file and folder names as they are. Use this option if you
are using ISO format discs to make incremental backups from your Macintosh.

➤ Stop Discs created with this naming option can only be used on Macintoshes!

Joliet (MS-DOS & Windows95)

This is an extension to the ISO format which allows the disc to preserve long file names for
use under Windows95 and WindowsNT, while also being fully compatible with older versions
of DOS and Windows.

A Joliet format disc contains two file systems: An ISO 9660 compliant file system using MS-
DOS names, and the Joliet file system using long Unicode names. Both file systems point to
the same data files. Remember that only Windows 95 and Windows NT 4.0 systems will have
access to the long names, while ISO 9660 compliant systems such as MS-DOS, Unix, or Mac
OS will only see the ISO 9660 file system. A Mac/ISO hybrid disc created with Joliet names
will actually contain three different file systems: HFS, ISO 9660 and Joliet.

Name requirements:

• Length: 31 characters

• Characters: These characters are not allowed */:;?\

• Example: 1998 Report to Shareholders

Toast does not change file names when Joliet is selected. Instead, illegal names (containing
*/:;?\ ) are flagged with three red exclamation marks in the file list.
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You can use the "Copy" command in the "Edit" menu to export a list of all illegal names to
the clipboard.

Viewing the Short Names under Joliet

To view the short names seen by MS-DOS or (if you're not creating a hybrid disc) Macintosh
systems go to the "Settings" panel and switch to "Allow MS-DOS Names". 

Note: If you change a short name the long (Joliet) name will be changed too.

Other Settings

Append Version Numbers (;1)

This option adds the standard ISO version number (;1) to every file name. This version
number is normally invisible, and is seldom needed. This option is not available with Mac
names.

➤ Stop The installed ISO driver does not usually display version numbers even if they are on the disc. If
you want to see full names on the Mac press the option-key while inserting the disc.
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Use Apple Extensions

Check this option to have Toast write both the data and resource forks for Mac files.

This has no effect when the disc is read on a PC.

For hybrid discs this option is not needed, as both forks are always written to the HFS part of
the disc.

Set Defaults

Clicking this button will preserve your current settings as the default for future Toast sessions.

More

Clicking the More… button lets you enter a variety of additional information that will be
written to the disc as part of the directory. 

➤ Note In most cases this information is not visible or accessible to the user.
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Concerning Rockridge Extensions for UNIX
Toast cannot create discs with the Rockridge extensions for UNIX. It can, however, write 
images created by UNIX utilities such as “mkisofs” which do incorporate Rockridge name
extensions. 

The Appearance of Windows on the Disc
On a Mac all windows of an ISO disc will be sorted “by icon”.

➤ Note If you use ISO format to make backups for a Mac, you might want to use short files names so
that they don’t overlap when viewed “by icon”.
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The “ISO 9660 – Multisession” Format

This section covers adding an ISO 9660 session to a disc which already contains at least one
additional ISO session. There are several different strategies that can be used when adding an
ISO session. Each approach is covered below.

Before deciding which approach to use, you need to know what relationship the data in your
new session has to the existing data. For example, does the new data supersede the old data?
Or is it additional data that should be stored along with the old data?

The three primary strategies are:

- Ignore old sessions

- Append to old sessions

- Incremental backup session

Adding an ISO Session
To add a new ISO session to a disc, begin by selecting your new data in the normal fashion
(as described in chapter 5.)

Once your data is selected, click the Write CD… button in the main window.

This dialog box will appear:

Ignore Existing Sessions

Choosing this option will produce a CD which appears to contain ONLY the data from the
new session. All old data will be gone (it’s not actually gone, since CDs cannot be erased, but
you will no longer be able to access it.)

➤ Note There is no way to view these “old” sessions. Only use this option if you are sure that older
sessions are no longer needed.
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Append to “Name of the previous Session”

This option results in a disc that has the name of the new session as its volume name or label
and which has both the new data and the old data together in the “top” level of the directory
structure.

Example:

In this example, two folders
named “John” and “Smith” were
originally written as a session
named “Backup”.

A second session named
“Backup II” was added; it
contained one folder named
“Francis”.

Notice that the disc is now
named “Backup II” and that the
folder “Francis” appears at the
same level as the old folders.

➤ Note It is also possible to selectively “delete” folders from the structure. For example, let’s assume
that the folder “John” is no longer needed. In the ISO dialog create a new folder, give it the
name “John” and define it as Invisible (see “Renaming Files & Folders and Changing Visibility”
earlier in this chapter). Then add any new data you may want, and write the session. The new
data will be added to the structure and the folder “John” is no longer visible.
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Incremental Backup

Selecting Incremental Backup causes Toast to write only the files and folders which have
changed since the last session. 

➤ Note For this to work correctly you need to select the same volume or folders for each session. If
you select completely different data, the results of an incremental backup will be the same as if
you selected “Ignore existing sessions”.

See chapter 5 “ISO 9660” “Examples”: “Example 1”.

Importing a Session from a Disc
For the ultimate in control, Toast allows you import the directory of previous ISO sessions
and then edit and make any changes you want. You can delete, rename, move, and reorganize
any of the files and folders of the old sessions.

To import an existing session, make sure the CD is in your recorder, then:

1) Click the arrow on the lower right side of the window and select Import Session.

If there is at least one ISO session already written on the disc, the Import Session dialog
will be displayed:

2) Select the desired session to import (usually you would select the most recent session.)

➤➤ WARNING: If you import a session other than the most recent one, you will not be able to
see any data from the sessions written after the one you have imported!
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3) Specify how you want the session to appear in the new session’s directory by clicking
one of the radio buttons.

If you select Merged, the name of the session will become the name of the new session and
the data of the old session will become the data for the new session.

If you choose Put into a directory the old session is put in a directory with the name of the
session. If no data was selected before, a new CD directory is created containing one
folder which contains the data from the old session.

4) Click OK.

The imported session will be displayed in the ISO directory window. Files that are already
written on the CD are marked with a small CD icon by their name.

Modifying an Existing File Structure
At this point you can make any desired changes to the file structure.

You can make any or all of these changes to the structure:

• Files and folders can be moved to another position.

• Files and folders can be added or removed

• Files, folders and the disc can be renamed.

• The visibility of files and folders can be changed.

• New data can be added to any part of the directory structure.

The way you arrange the data will determine the layout of the disc once you write the new
session. 

➤ Note To conserve disc space, files which are already on the disc are not written to the disc again;
the directory structure is simply altered to match your changes.

Removing an Imported Session

To remove an imported session from the ISO directory window, select Remove Imported Session
from the pop-up menu in the lower right corner of the window. All the files and folders from
the imported session will be removed from the window, leaving only new data which you may
have added.
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The “Mac/ISO Hybrid” Format

This section covers the creation of Mac/ISO Hybrid discs. Hybrid discs may seem complex at
first, but if you follow the simple guidelines presented here, it’s a snap.

Preparing the Mac Portion of a Hybrid Disc
For a hybrid disc, the Mac data must be by itself on a volume or partition.

This volume or partition should contain all the data for the Mac portion of the disc, as
well as all the data which will be shared by both the Mac and ISO portions.

You may arrange the data in any way you like, and the shared data may be located anywhere
in the directory structure of the Mac volume.

For details please see “The Mac Volume Format” earlier in this chapter.

About Block Size and Shared Data
In order to write a hybrid CD containing shared data (data visible on the Mac and the PC), the
block size of the Mac volume must be a multiple of 2048 Byte (2 Kilobyte), unless you choose
the Optimize option in the volume selection window.
The block size of the volume is shown in the Info… dialog (see “The Info Dialog” in “The
Format Mac Volume” earlier in this chapter).

If the block size of the selected Mac volume is not a multiple of 2 K, you have these options:

• You can check the option Optimize for Speed (“Optimize for Size” is not available in Hybrid
format), which will allow the data to be shared. 

• You could simply choose to write the common data to the disc twice, once for the Mac
part and once for the ISO part. (This of course requires that there is enough room on the
disc for two copies of the shared data.)

• You can create a temporary partition using Toast for use as your Mac data source. 
Temporary partitions created with Toast automatically have the correct block size for 
shared data. (See chapter 15 “The Utilities Menu”)

• Reformat your hard disk and choose a compatible block size.

The ISO Part of a Hybrid Disc
The data for the ISO portion of a hybrid disc can reside anywhere on your hard drives. You
simply drag the desired files and folders into the ISO window in Toast to select the data.

• If you select data for the ISO part which is located on the volume which you selected
as the source of the Mac data, that data will automatically be shared, and hence will be
written to the disc only once.
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• If you select data from other volumes or directories, it will be visible only on PCs.

For details about the different settings please see “The ISO 9660 Format” earlier in this chapter.

➤ Note If you prefer to prepare data for hybrid CDs by using an ISO folder and aliases to the shared
data (as required by older versions of Toast), you can still use that method with Toast version 3.

Why Multisession Hybrid Discs are a Bad Idea
While it is possible to create a multisession Hybrid disc, this is generally not recommended.

• No link can be established between the different sessions, which means you would end up
with a multi-volume disc.

• On the PC only the data of the last session would be visible; earlier sessions will be
ignored. (On a Mac each session would appear as a separate volume.)

➤ Note It is OK to write a Hybrid session as the second session after an audio session. An audio CD
player would then see only the audio tracks, while computers will see both audio and data.

Testing your Hybrid Disc Before Writing
You can test the layout and contents of a hybrid disc before writing to make sure it is set up
the way you want it.

1) After selecting all the data, choose Save as Disc Image from the File menu.

The Mac and the ISO part are saved as a single disc image file.

2) Select Mount Disc Image from the Utilities menu..

Two volumes are mounted on the desktop: one for the Mac part and one for the ISO part.
You can then open the volumes to review their contents. (No changes can be made to
volumes mounted in this manner.)

You can then review the layout of both volumes, and make any desired changes befor
writing the image to disc using the DISC IMAGE FORMAT. (Select Disc Image
Format and choose the saved hybrid disc image as the source.)
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Toast’s Greatest Hits & Audio CDs

Toast’s Greatest Hits lets you create audio CDs by simply dragging tracks from existing CDs
or sound files onto the Toast track list. 

• Tracks can be copied directly from the original CD without having to save them to a hard
drive first. You can even select tracks from different CDs and Toast will prompt you to insert
the correct source CD while writing the new disc.

• Toast can also write audio CDs from standard Mac sound files. Toast recognizes
SoundDesigner II or AIFF sound files (they must be in 16-bit, 44.1 kHz format)

You can combine these two methods if desired.

Note: direct copying of audio tracks requires a CD-ROM drive which supports audio
extraction and a Macintosh which supports SCSI Manager 4.3.

Selecting Tracks
There are two methods of selecting audio files or tracks for writing to a CD.

1. Drag & Drop Method

Select the desired audio files in the Finder and drag them onto the main window.

When selecting from an audio CD, you can drag one or more tracks, or simply drag the
icon of the disc to select all the tracks.

149Chapter 16



2. The Selection Method

Clicking the Audio… button in the main Toast window will display the AUDIO TRACKS
window, shown here:

Click Add… and select the desired files in the dialog which appears. To import all files in
a given folder click Open all while the contents of that folder is displayed.

Rearranging the Audio Files
You can drag the individual audio tracks around in the AUDIO TRACKS window to change
the order that they appear on the finished disc.

Removing Tracks

To remove tracks from the list, select the desired files and click Remove.

➤ Stop Removing items from the list cannot be undone, but you can re-import the file if you remove
something from the list by mistake.

Previewing Tracks

To play a track select it in the AUDIO TRACKS window and click the Play button. The track
will be played back using the Mac’s internal audio output. If the track is on a disc which is not
currently mounted, you will be prompted to insert it.

➤ Stop Playing audio tracks requires the system extension “Sound Manager”.
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Saving Tracks as Sound Files (Audio Extraction)
Toast can save an audio track as a standard AIFF sound file. Simply select the desired track or
tracks in the track list and click the Extract button. You will be prompted for a destination for
the files.

➤ Note When you extract a track, Toast will update the track list to refer to the extracted file, rather
than to the source CD for that track.

Naming Your Source CDs & Tracks
For convenience while organizing and writing compilation discs, Toast uses the disc and track
names which have been entered with the AppleCD Audio Player. If the Apple database
contains names for any tracks selected, those names will be used by Toast.

You can edit these names using Toast, or with the AppleCD Audio Player.

• To edit the names with Toast, double-click on any item in the track list to display
the naming dialog:

Enter the desired disc and track name(s) then click OK. You can use the arrows to move to
a different track. (If you change the name of a track which is based on a sound file, rather
than a CD track, the name of the source file will be changed.) 

• To edit the names using the AppleCD Audio Player, select the player from your
Apple menu:

Enter the desired disc and track name(s) in the appropriate fields.
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Writing from multiple source discs

If you have selected tracks from more than one disc, Toast will display a list of the discs
when you click the Write CD button.

Make sure you have all the required source discs available before proceeding, as the
write process cannot be aborted once begun.

While writing, Toast will prompt you to insert the appropriate source disc as it reads each
track:

The Pause between Tracks

Toast automatically inserts a 2 second gap between each track. If desired, you can specify
a different gap using the Pause menu. The menu will set the pause before the selected
track(s).
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If your recorder does not support pauses of less than two seconds, you may see this
message:

Check the Toast READ ME file on the installation disc for more information.

Index-Points – Text and Numeric Markers

If you have defined index points in your SoundDesigner II files, Toast will recognize them
and write them to the disc. To read the markers in your sound files, select the marker type
from the Index pop-up menu.

Choose Text Markers or Numeric Markers depending on the type of markers you defined. The
number of markers is then displayed in the track list.

➤ Note Index-points are seldom used, because most audio CD players cannot use them (or even see
them).

WARNING: Index-points cannot be used as track start points. They are additional positions
within a track which some audio CD players can use to go directly to a specific spot within a
track. (see chapter 2 “Terminology”).

Not all CD writers are able to write index-points in track-at-once mode (the mode used by
Toast). If your writer does not support index points, a dialog box will be displayed to warn
you when you try to write the CD.
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The “CD-i” Format

Toast can write a CD-i disc from a CD-i image; these disc images are generated by various
CD-i authoring systems like Media Mogul from Philips.

Toast cannot create CD-i disc directly from “dyuv” or video files.

Scrambling
Toast can accept CD-i disc images that are scrambled or unscrambled. The application
automatically detects the file type and writes the disc accordingly.
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The “Video CD” Format

Toast can create a Video CD in two ways:

• by writing a Video CD disc image created by a Video CD authoring system

• by using individual MPEG streams multiplexed with “ASTARTE M. Pack”

Video CDs can be played on Video CD players, CD-i players and computers with MPEG
decoder cards.

See Chapter 9 for information on the proper settings for creating MPEG streams for use on
Video CD’s.

A Video CD from a Disc Image
All menu pages, links, and MPEG streams defined in your Video CD authoring software will
be written to the disc when writing from a disc image.

A Video CD from MPEG Streams
When you create a Video CD from one or more MPEG streams, the resulting disc will not
have menu pages or links. It will function more like an audio CD. The following functions
will be available when playing the disc in a Video CD or CD-i player:

• play first (or only) video

• jump to the next video if available

• fast forward and rewind

• pause

• stop

If you need more flexibility in your Video CDs you will have to create them using an
authoring system and then write the discs using a disc image.

Adding MPEG Tracks to a Video CD

After selecting Video CD from the Format menu, click the Data… button in the main window.

The MPEG Tracks window will appear.

Click the Add… button to select files to be added to the track list. You can also specify a name
for the disc (if desired).
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Changing the Order of the Tracks
To change the order of MPEG tracks, simply select them and drag them to the desired position
in the list.

The order of the files in the list determines the order of the tracks on the finished disc.

Removing MPEG Tracks from the List
If you wish to remove imported MPEG-streams from the list, select the desired files and click
Remove.
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The “Enhanced Music CD” Format
➤ Note Creation of Enhanced Music CDs can be quite complex. This section is intended only as an

overview of the process. We recommend that you refer to the documentation included with
your Enhanced Music CD authoring system for more information.

An “Enhanced Music CD”, also called “CD Extra” and formerly known as “CD Plus”, is a
disc which contains audio tracks in the first session and a data track in the second session. The
data track has to conform the specifications of the Blue Book, which requires a precisely
defined file structure.

Toast creates Mac/ISO hybrid Enhanced Music CDs with shared data.

➤ Note “CD EXTRA” is a copyrighted name. This name can only be used on your disc if it conforms
the Blue Book standard. Discs which have a second session in any other format are not really
CD Extra format.

Toast supports the creation of 100% Blue Book conformant discs.

Steps to Creating an Enhanced Music CD
The first step in creating an Enhanced Music CD with Toast is to create an Audio CD
containing the desired tracks (see chapter 7 for information on creating Audio CDs)

Be sure to choose Write session rather than Write disc when creating the audio disc, or Toast
will not be able to append the Enhanced Music CD session to the disc.

Toast is able to create Enhanced Music CDs from

• a pre-made CD EXTRA directory hierarchy, or

• a QuAC file.

Using a pre-made Hierarchy

Launch Toast and set the disc format to “Enhanced Music CD” 

Click the Data... button and select a volume to be used for the CD.

If you do already have a valid hierarchy, just select a Macintosh HFS volume which contains
the “CDPLUS” and “PICTURES” directories in a directory called “CD EXTRA” at its root
level.

The root level “CD EXTRA” folder will be used to create the ISO part of the CD. 

Toast will check the integrity of the directory hierarchy and report any problems found. 
See “CD EXTRA Hierarchy” below for further details.
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Using a QuAC File

To create a Enhanced Music CD from an existing QuAC file, simply put the file into the root
directory of a Macintosh HFS volume. When you select the volume, Toast will ask you
whether you want to use the QuAC file to make a Enhanced Music CD and will create a
directory hierarchy from the QuAC file for you. 

See “QuAC Files” below for further details.

All Enhanced Music CD discs created with Toast are hybrid Macintosh HFS / ISO-9660. The
ISO part will contain all the files in the “CD EXTRA” folder of the Macintosh volume.

Files in the “CD EXTRA” folder are automatically shared, with two exceptions: 

• INFO.CDP is duplicated in the ISO part, because it has to be placed at relative sector
address 75 according to the Blue Book standard. 

• The MPEG pictures are not shared either because they are recorded in form 2 sectors.

Before Toast writes the disc it verifies the integrity of the data structures. If everything is fine,
the relative sector offset addresses will be updated and the CD written.

QuAC Files
In 1995 Apple introduced the QuickTime Audio Containable standard for documents that 
contain information for music CDs as well as pictures and optional interactive controls.

When you choose a QuAC file as your data source for a Enhanced Music CD, Toast will create
a structure like this:

lc = language code, e.g. “de” for german, “en” for english, etc.
nn = Track number; 01, 02,… for the single tracks, 00 for the whole album

Toast will only create files for which data actually exists, but it will always create the
INFO.CDP, at least one SUB_INFO.lc and four picture files.

Mac Volume CD EXTRA CDPLUS INFO.CDP
SUB_INFO.lc
LYRICSnn.lc
TRACKnn.MID

PICTURES JACKET01.00J
JACKET01.00N
JACKET01.00S
JACKET01.00T

AUTORUN.INF

The QuAC File

Other Macintosh data
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Picture files will be created for the front cover picture of the album only. Toast will substitute
MPEG files using a set of internal replacements pictures (showing the CD EXTRA logo). If
desired, you can replace these files with your own sectorized MPEG pictures in the proper
resolutions (NTSC or PAL).

The QuAC file will appear at the root level of the ISO volume.

CD EXTRA Hierarchies
Toast can also make an Enhanced Music CD disc from a manually constructed directory 
hierarchy. The structure has to be similar to the one described in “QuAC Files” above.

Toast CD-ROM will verify several parts of the directory structure before starting to write it to
CD. In particular, Toast will check the following criteria:

Directories

A “CDPLUS” and a “PICTURES” directory must be present in the “CD EXTRA” directory in
the root directory of the Macintosh HFS volume.

INFO.CDP

The file “INFO.CDP” must be present in the “CDPLUS” directory. It has to conform to the
Blue Book specifications and contain space for pointers to each of the ”SUB_INFO.lc“ files.

SUB_INFO.lc

The “SUB_INFO.lc” files have to be valid, i.e. they have to conform to the Blue Book
specifications and contain space for pointers to each of the “TRACKnn.MID”,
“LYRICSnn.lc”, and picture files.

AUTORUN.INF

If there is no “AUTORUN.INF” file in the “CD EXTRA” directory of the HFS volume, Toast
will will create a simple file with just the line “[autorun]” in it. You can edit this file, but
remember to save it in CRLF format.

Picture Files

Toast only accepts picture files with file extensions of the form nnx (e.g. JACKET01.00J or
VANESSA.01J) where nn is a track number (or 00 for the whole album) and x is the format
type which could be any of J, N, T, S, P, A, or L.

At least the JPEG files have to be present, MPEG files will be substituted using Toast’s built-
in set of MPEG replacement pictures (showing the CD EXTRA logo) if they are missing.
If MPEG files are present, they have to be fully sectorized (2352 bytes/sector). They must not
be scrambled. The header and sync fields will be patched during recording, but the subheader
has to be correct.
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The “SCSI Copy” Format
SCSI Copy is used to make a direct copy from a hard drive, CD-ROM drive or other SCSI
volumes, to a CD. It is ideal for making exact copies of existing data CDs.

When you click the Data… button while in SCSI Copy mode, this window will be displayed:

If your Mac has more than one SCSI bus, select the desired SCSI Bus from the pop-up menu
to view the devices connected to that bus.

Searching the SCSI Bus
If you switched on a SCSI device after opening this window the device will not appear in the
list. Click Re-Scan to search the SCSI bus and list new devices.

Options

After you have selected a device in the list, the Options… button will be available. Click it to
set these options:
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Normally both options should be checked. If you are copying a bootable CD, uncheck “Clear
Driver Descriptor Map”.

If you are not sure what you are doing, just accept the default settings.

The Amount of Data to be Copied

After selecting a device to copy, click OK. This window will be displayed:

SCSI copy normally copies the entire volume, even if not all the space contains data.

If desired, you can change the number of blocks to be copied to eliminate the copying of
empty space. You should only change these settings if you are very sure of what you are
doing. Incorrect settings can result in a useless disc.

➤ Note When copying a disc which you have written yourself, the Number of Blocks to copy will be
less than the total number of blocks on the disc. Toast makes this adjustment automatically,
since the Mac cannot read the last blocks from a CD-R.

See Example 1 in chapter 11.

➤ Stop Mac volumes should not be copied using SCSI Copy; it is always preferable to use the “Mac
Volume” format.
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When Copying a CD
Copying a CD only works under these conditions

• The disc may only contain one track in one session.

• The disc may only contain sectors which can be read by the Mac: Mode1 or Mode2
Form1 sectors (see “Terminology” in chapter 2).

• Discs containing Mode2 Form2 sectors cannot be copied as the Mac cannot read those
sectors (see “Terminology” in chapter 2).

• Your CD-ROM drive must be faster than your selected recording speed. For example,
if you want to record the copy at 2x, your CD reader must be at least a 4x.

➤ Note To copy audio CDs use the Audio CD format and drag the icon of the audio disc onto the track
list window to select all the tracks.
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The “Disc Image” Format
Disc Image format is used to write a previously saved disc image to a CD. Disc images can be
created in Toast, by using the “Save as Disc Image” command (see “Save as Disc Image” in
chapter 15 “The File Menu”). Disc image files can also be generated by some multimedia 
authoring systems and other specialized applications. 

➤ Note Video CD or CD-i disc images created in their respective authoring systems should always be
written in the corresponding format, NOT the Disc Image format.

When you select Disc Image format for a disc, the Data… button displays this file selection 
dialog:

Auto-Detect Format
Turning on this checkbox sets Toast to automatically determine the appropriate CD format for
any disc image that you select. Normally you should leave this option checked.

If you need to set the format options manually, uncheck the Auto-Detect Format checkbox.
When you select an image and click Open, following dialog is displayed:

Only change these settings when really necessary!
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Pregap and Postgap

You can change these from the standard settings.

Sector Size

The Sector Size is set automatically according to the contents of the disc image. You may
change it using the pop-up menu.

Scrambled

If the selected disc image is NOT scrambled, uncheck the Scrambled checkbox.

Once you have selected an image file, and click Open, the size and format of the data will be
displayed in the main window.

Mounting Disc Images
You can mount the selected disc image as a volume on the desktop in order to check its
contents. Simply click the Mount button. (If no image file has been selected, clicking the Mount
button will display a file selection dialog.)

➤ Note If you mount a Mac/ISO Hybrid disc image two volumes will be mounted on the desktop, one
for the Mac part and one for the ISO part of the disc image.

➤ Stop A disc image file must be stored in contiguous disk space in order to be mounted. If your disc
image is fragmented, use a commercial disk optimizer (e.g. Norton Speed Disk) to defragment
the volume which contains the image.

A disc image can also be mounted by selecting Mount Disc Image from the Utilities menu. For
details see chapter 15 “The Utilities Menu”.
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The “Multitrack CD-ROM XA” Format
This format is used for writing several CD-ROM XA tracks in one session. Most CD-ROM
formats consist of only one track per session and therefore the “Multitrack CD-ROM XA”
format is very seldom used.

When you select the Multitrack CD-ROM XA format, and click the Data… button, this track 
selection window is displayed:

Use the Add… button to select the XA image files that you want to include on the disc or drag
them onto the window.

Options for XA Tracks

The Options… button allows you to change the block size for the select track:

It is normally set to the correct value automatically so don’t change it unless your really
know what you’re doing.
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The “Audio Tracks” Format
The “Audio Tracks” format is used to add audio tracks to another data format to create Mixed
Mode CDs. The Data and audio is written in one session. The data track is always placed
before the audio tracks on the disc and there is no way to change this order.

➤ Note If you write a CD with audio tracks selected but no data, the result will be a standard audio CD.

➤ Stop If you write a disc in this format with both data and audio tracks, the data track should not be
played in a standard audio CD player. Because the data is part of the first session, the audio
recorder would be able to “see” the data tracks. Playing data tracks can be harmful to an audio
system, especially speakers.

The Mixed Mode format has generally been superseded by the audio/data Multisession format
where the first session consists of audio tracks and the second session consists of data (CD
Extra or second session in HFS, ISO 9660 XA, Mac/ISO Hybrid XA format). Using this
format the data track is not visible in audio CD players. (Some older CD-ROM driver
software will not mount audio/data Multisession disc. See the publisher of your CD driver for
more information.)

Requirements for audio tracks as well as explanations on how to import, delete or move audio
tracks can be found in the section “The format Audio CD” earlier in this chapter.
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Chapter 17: The Transfer Rate and the
Write Procedure

____________________________________________________________________________

What is Transfer Rate?
In order to successfully write a CD, Toast has to be able to get your computer to supply a
steady stream of data to the recorder. How fast the data has to be supplied depends on the
writing speed and disc format that you’ve selected.

The speed of data flow is called the Transfer Rate; it indicates how many kilobytes of data
are transferred in one second from the Mac to the writer. 

This chart shows the transfer rates required for different formats and writing speeds:

Checking the Transfer Rate
To minimize wasted discs, Toast gives you two different tools for verifying that you have 
adequate transfer rates: Check Speed and Simulation Mode (Simulation Mode is covered later in
this chapter).

You can check the transfer rate before writing to see whether your system is fast enough to
write with the desired speed.

To run the Check Speed procedure, click the Check Speed… button in the main window (make
sure you have selected your data first!). This window will be displayed and the checking will
begin automatically:

Write Audio & HFS, ISO, Hybrid
Speed Mode2 Form2 Mode1 / Mode2 Form1

1x 172 K/s 150 K/s

2x 344 K/s 300 K/s

4x 689 K/s 600 K/s

6x 1033 K/s 900 K/s
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The speed check proceeds as follows:

1) If you checked the option Optimize in “Mac Volume” or “Mac/ISO Hybrid” format
the Optimize progress window will appear while the files are rearranged.

2) The RAM cache is then filled with data read from the source volume. (The size of the
RAM cache is set in the Preferences dialog in the Edit menu.)

3) The Recorder cache is filled.

4) All selected data is read.

The two vertical bars indicate how much data is currently stored in the RAM caches. The
downward-facing arrows mark the lowest point that the cache level reaches during the
checking process.

It is normal for the levels to fluctuate during testing, however, if the Recorder Cache bar reaches
the bottom at any time during the speed check, it means that the data rate is too low. If that
happens, the FAILED indicator will appear:

169Chapter 17



➤ Stop Do not write the disc with these settings, as the write procedure will most likely fail and the CD
will be wasted!

If you want to check the data rate for a different writing speed or a different recorder model,
click the Stop button, then make your new selection from the Simulation or Speed menus, and
click Start. (These menus are initially set to match the connected recorder.)

Error Messages

You might get the following error message while checking the transfer rate:

This can happen if you try to copy one of the following CDs using SCSI Copy mode: 

• CD-i, Video CD, Photo CD, CD Extra or

• another disc with audio or Mode 2 Form 2 sectors or

• a disc containing more than one track or 

• a disc containing more than one session.

Do not try to write the disc if you get this message!

➤ Note If you want to copy such a disc you will need to obtain special software that converts the
tracks into readable files, e.g.” ASTARTE CD-Copy”.

➤ Stop “Check Speed” is only an approximation (the data is read but not transferred to the writer). If
the results of the speed check are borderline, you should try Simulation Mode, which gives a
much more accurate evaluation. (For details, see the next section or “The Recorder Menu” in
chapter 15).
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What to do if “Check Speed” fails
These are some possible solutions if “Check Speed” failed:

• Set the write speed to a lower value. For details see “The Write procedure” later in this
chapter.

• Use an AV hard disk with no thermal recalibration while writing (please refer to your
dealer for details about your hard disk).

• Turn off all system extensions which are not needed. If you use System 7.5 you can
boot with all extensions off (hold down the shift-key while starting your Mac).

➤ Note Toast does not require any extensions to run, however, if you are copying from a CD you
will need to run the appropriate driver software for your CD-ROM drive. Also, on older
Macintoshes, you may need to run the SCSI MANAGER, the THREAD MANAGER and the
DRAG & DROP MANAGER extension to take advantage of some of the features of Toast.

• Turn off all network connections when writing data placed on local volumes.

• Remove all devices from your SCSI chain which are not needed at the moment. Some
devices slow down the SCSI bus (especially removable media drives and scanners.)

• Check cables and terminator. Slightly defective cables or terminators may slow down
the SCSI bus, even though the effect may not be noticeable in normal use.

• If your Mac supports SCSI Manager 4.3:

- Increase the RAM Cache (Preferences from the Edit menu).

- Make sure your hard disk driver is able to work in asynchronous mode (With
System 7.5 the driver information is displayed in the “Get Info” dialog for the hard
disk in the Finder.)

• Create a disc image of the selected data before writing. Please refer to the next section
for details.

171Chapter 17



The Write Procedure
After satisfying yourself that the transfer rate is adequate, you are ready to write the disc.

• Insert a recordable CD with enough free space to write the selected data. (To check
the free space available on a disc, choose Disc Info from the Recorder menu.)

• Click Write CD….

• If there is no disc in the recorder this message will appear:

• Toast will now verify that it can locate all the data that you selected.

If you selected many files this procedure may take a while. (If you are sure that you didn’t
move or rename any items after selecting them you can skip the verification.)

If one or more selected items could not be found, an error report is displayed:

If you click OK Toast will remove these items from the list and will not write them to CD.
Click Cancel if you want to locate the files and reselect them in the data selection window.
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• If you have chosen ISO 9660 format and the inserted disc already contains at least
one session, the ISO Multisession dialog is displayed:

Click on the desired option to determine how the new session is linked to existing sessions.
(For details please refer to chapter 16 “The ISO 9660 – Multisession Format”.)

• If you checked the Optimize option, Toast will prepare for the optimization process (if
your data contains many small files, this can take some time):

• If there is not enough free space on the disc for the selected data, Toast will warn you:

You cannot write the disc if there is not enough space for the selected data.

• If Use Autoloader or Use Kodak Disc Transporter (Utilities menu) was selected:
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Enter the Number of Copies you want to be written. If you want the disc to be closed so that
no further data can be added later, check Fixate Discs. For details see chapter 15 “The
Utilities Menu”.

• The Write Dialog will appear

The Write Dialog

The Write Dialog lets you set a variety of options for the writing process.

Speed

Use the Speed menu to select the desired writing speed (this menu is a duplicate of the Write
Speed menu in the Recorder menu). Only those speeds which apply to your recorder will be
available.

The last write speed used in “Check Speed” will be set by default.

Simulation Mode

Simulation Mode allows you to run through the entire process of writing the disc, exactly like
the real writing process, except that the laser is not turned on in the recorder, so nothing is
written to the disc.

• All error messages which would be displayed while writing will also be displayed in
simulation mode.

• Simulating the write procedure takes the same amount of time as writing.

• When simulation mode is selected *** Simulation Mode*** is displayed in the menu bar
in red letters.

➤ Note During simulation, the “write” indicator light on the recorder will turn on, just as if you were
actually writing. This is normal, and does not indicate that the disc is really being written.
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The simulation mode gives more exact results than “Check Speed” since the data is actually
transferred to the writer. (see “Checking the Transfer Rate” earlier in this chapter).

Create Disc Image first

If your Mac is not fast enough to write with the selected speed or to optimize a Mac volume
while writing you can choose to create a disc image of the selected data before writing the disc.

If you check this option, the disc image will be created and then writing will begin
automatically, using the image as the source.

➤ Note If you are not sure that the transfer rate is high enough to write the disc image with the desired
speed, use the Save as Disc Image command from the File menu after selecting the data (see
chapter 15 for details). Then choose the Disc Image format to write the saved disc image and
check the transfer rate again.

Writing a Session

Click Write Session if you want to be able to add additional data to the disc at a later time.

If you checked the option Create Disc Image first you are asked to select the place to save the
image file. The image file takes the same amount of disc space as the selected data.

➤ Note If you are not sure whether you will add more sessions to the disc later, just choose Write Session
anyway; it makes no difference when using the disc if you wrote it as session or not. However,
if the disc will be used as master for a duplication plant it should always be closed 
(see “Writing a finalized Disc” later in this chapter).

The Write Session command is not available if:

• The selected data occupies more than 625 MB.

• There would not be enough space left on the disc to write another session.

• You write in “ISO 9660” or”Mac/ISO Hybrid” format and you did not select the “CD-
ROM XA” option for the format (see chapter 16 “The ISO 9660 Format” for details).

➤ Stop Each new session on a disc requires additional space to hold the directory structure.

• the first session uses approximately 23 MB

• each additional session takes approximately 12.5 MB.

Consequently, if you write many small sessions, the disc will hold less data than if you write 
larger sessions.
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For example:

These 9 sessions use a total space of 52.1
MB if you just add up their sizes.
In theory that would leave 598 MB available
when starting with a CD-R with 650 MB of
free space.
However, Toast shows that is only 474 MB
available; 124 MB was used for the sessions´
overhead.

Theoretically you could write a disc containing 99 sessions each having approximately 6.56 MB
of data (6.56 MB x 99 = 649.44 MB). But because of the additional overhead you can only have
33 sessions each using 6.56 MB. ((6.56 MB + 23 MB) + (32 *(6.56 MB + 12.5 MB))) = 639.48 MB.

Writing a finalized Disc
If you want to write the selected data and close the disc so no more data can be added later,
click Write Disc. 

If you checked the option Create Disc Image first you are asked to select the place to save the
image file. The image file takes the same amount of disc space as the selected data.

➤ Note If the disc will be used as master for a duplication plant it should always be closed.
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After Writing
After all the data is written the following dialog is displayed:

If you do nothing or if you click Verify, the newly written data is compared with the original
data on a block level.

If there is a data mismatch Toast will display a notification dialog.

If both the original and the copy are identical, you get the following message:

➤ Note Audio CDs, CD-is, Video CDs, Enhanced Music CDs and Multitrack CD-ROM XA discs cannot
be verified after writing.

You can also compare the original and the copy by choosing the Compare command from the
Utilities menu. The Compare function works on a file-by-file basis, rather than block-by-block,
so Toast will be able to list specific files that don’t match. (see chapter 15 “The Utilities Menu”
for details)

• If the option Calculate a checksum while verifying in the Preferences (Edit menu) was checked,
the checksum is displayed after verifying (see chapter 15 “The Edit Menu” for details).

• Select Copy from the File menu to copy the checksum or simply write it down.
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Chapter 18: About CD-rewritable Drives
____________________________________________________________________________

CD-Rewritable is a new technology that allows a recordable CD to be erased and reused. To
take advantage of this technology you need a CD-rewritable drive and special erasable media.

If you have a rewritable drive, you can erase your disc at any time by inserting the disc in
your recorder, selecting the DISC INFO command from the RECORDER menu and clicking
the ERASE... button.

The Erase Confirmation dialog gives you the option to perform a Quick Erase or a Standard
Erase. Quick Erase erases only the TOC (Lead-in) and the pregap of the first track, which is
very fast. This option is ideal for discs that will be written with Toast but is not compatible
with packet-writing. If you want to be able to write the disc with software other than Toast, be
sure to select the standard Erase button.

Toast can erase in the background if SCSI 4.3 is present. Erasing can not be aborted. 

Toast ejects the disc after erasing without any further messages.
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Appendix A: Toast and AppleScript
____________________________________________________________________________

Toast 3.5 is fully scriptable using AppleScript. Virtually any type of CD mastering tasks can
be automated.

When you ran the Toast installation program it installed several sample scripts on your hard
drive. These will give you a glimpse into what’s possible with Toast and AppleScript.

Toast & Shutdown script

This simple script writes a CD and then shuts down the machine. This might come in handy if
you’d like to start a CD writing session before you leave the office. The script assumes that
Toast is running and ready to start writing (data selected, etc). In case of an error the script is
aborted and the Mac is not shut down, so that you can examine the cause of the error when
you return.

Copy SCSI Disk script

This is a sample script that demonstrates how you can setup Toast to copy the first 30 MB of
the SCSI device at Bus 0, ID 0 (usually the internal hard disk) to CD. (You normally wouldn’t
want to do that.)

Drop*Burn script

A somewhat more complicated script which writes items dropped onto it to CD. It
demonstrates how AppleScript can be used to create a customized user interface for Toast.

Hybridizer script

This sample Droplet offers an easy way to set up a Mac/ISO hybrid disc. Just prepare a Mac
volume as usual, and put all the ISO data in a folder on that volume. Then drop that folder
onto the Hybridizer icon.

For more information please open the AppleScript dictionary using ScriptEditor or other 
similar application.

NOTE FOR SOFTWARE DEVELOPERS:
Please contact us if you want to control Toast from your application via AppleEvents. A
header file containing useful constants and some documentation is available on request.

➤ Note It is beyond the scope of this manual to cover application scripting. However, there are many
good books available on the subject and the ADAPTEC web site (www.astarte.de) features links
to useful scripting-related resources.
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Appendix B: Troubleshooting
____________________________________________________________________________

This section contains answers to commonly asked questions about writing CDs with Toast.
The information is grouped by the following topics:

• The different disc formats

• Checking the Data Rate

• Before Writing

• While Writing

• After Writing
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“Mac Volume”

Some windows do not look the
same as they were on the
original. (i.e. you closed all the
windows, but when the CD is
mounted, some windows are
open.)

––––––––––––––––––––––––––
Although a volume’s amount of
used space does not exceed the
capacity of a CD-R you get the
message that the data will not fit
on the CD-R.

––––––––––––––––––––––––––
Although you checked Optimize
for Size the value for the amount
of data to be written displayed in
the main window seems to be too
big.

––––––––––––––––––––––––––
You select a volume and get the
following message:
“Your Volume” could not be
unmounted. All open files and
programs on this volume must
be closed first.
––––––––––––––––––––––––––
You drag a volume onto the
main window while the “Mac
Volume” format is selected.
Toast changes to another format
and selects the data in this
format.

––––––––––––––––––––––––––

The information about window
positioning, size and view is
only recorded by the Finder
from time to time. The latest
position was still not saved by
the Finder before the disc was
written.
––––––––––––––––––––––––––
The selected volume is
fragmented, i.e. the data is not
stored contiguously on the
volume. Click Info… to see how
the data is stored. The important
value is the Size of CD-ROM.

––––––––––––––––––––––––––
The amount of data which is
actually written is only displayed
after Toast has performed its
optimization procedure.

––––––––––––––––––––––––––
Volumes with open files or
applications cannot be written
without optimization.

––––––––––––––––––––––––––
Only local Macintosh HFS
volumes can be written in “Mac
Volume” format.

––––––––––––––––––––––––––

• Unmount the volume (drag it
into the Trash) and mount it
again before writing or

• open any application (the
Finder will then save all
window positions)

––––––––––––––––––––––––––
• Defragment the volume using

a commercial disk optimizer
(e.g. Norton Speed Disk™”)
or

• Check the Optimize option in
the Volume Selection
window.

––––––––––––––––––––––––––
Click Check Speed… on the main
window. Before checking the
data rate, optimization takes
place. Afterwards the real value
will be displayed in the main
window.
––––––––––––––––––––––––––
• Close all files and quit open

applications or
• check the option Optimize.

This will allow you to write
open files and programs.

––––––––––––––––––––––––––
Depending on the kind of volume
“Mac Files & Folders” (when a
server volume is dragged) or
“SCSI Copy” (when no HFS
volume is dragged) is selected.
The data is then loaded
automatically.
––––––––––––––––––––––––––
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You get the following message:
The Apple CD-ROM driver
could not be found. Would you
like to look for it?

––––––––––––––––––––––––––
You wrote more than one HFS
session on the same disc. When
you insert the disc you only see
the first session.

––––––––––––––––––––––––––
In older versions of Toast you
could mount a temporary
partition by double-clicking its
image file. Now when you
double-click an image file it just
opens Toast.

––––––––––––––––––––––––––
Even though a partially used
volume appears to be totally
defragmented (when viewed in
the Info… window), Toast still
reports that the entire drive is
used.

––––––––––––––––––––––––––

You checked the Bootable option
but no Apple CD-ROM driver
was found in the System Folder
of your startup volume. (Toast
uses the Apple CD driver to
create the necessary boot
information on a Bootable CD.)
––––––––––––––––––––––––––
Your current CD-ROM driver
does not support multisession
discs.

––––––––––––––––––––––––––
Since disc images can now be
saved for all formats, it might
not be desirable (or even
possible) to automatically mount
a disc image when double-
clicking it.

––––––––––––––––––––––––––
You may be using Norton
FileSaver™.
FileSaver places its invisible
files on the very last block of the
drive, which makes Toast
believe that the entire drive is
full.
––––––––––––––––––––––––––

Click OK and select the driver
which is to be used to boot from
the disc.

––––––––––––––––––––––––––
• If you have an Apple CD-

ROM Drive, install the Apple
CD-ROM driver version
5.1.x (or higher) or

• mount the disc using your
CD writer and the system
extension “Toast CD Reader”.

NOTE: Each HFS session is
mounted as an individual
volume/icon.
––––––––––––––––––––––––––
After double-clicking a disc
image in the Finder, Toast will
open with that image
automatically selected in the
“Disc Image” format. You can
then click on the Mount button
to mount the image.
––––––––––––––––––––––––––
Before writing, deactivate
FileSaver for the selected drive.
FileSaver will then delete its
hidden files and Toast will report
the correct amount of space used.

––––––––––––––––––––––––––

183Appendix B

Problem/Question Information Possible Solutions



“Mac Files & Folders”

When you drag files and folders
onto the selection window you
get the following messages: 
Please insert disk…
At the File Server “The
Server” registered as…
Some aliases couldn’t be
resolved:
––––––––––––––––––––––––––
You drag files and folders onto
the selection window. You get
the following message:
Couldn't complete the last
command because the volume
could not be found.
Error code = -35.
––––––––––––––––––––––––––
You insert a disc written in “Mac
Files & Folders” format and the
icons of files created by a
specific application don’t look
like they usually do.

––––––––––––––––––––––––––

The option Resolve aliases was
checked. The selected data
contains aliases which point to
data which cannot be found.
This often happens when you
drag a System Folder containing
folders like “Recently used
applications” or similar.
––––––––––––––––––––––––––
The option Resolve aliases was
checked. The selected data
contains aliases which point to a
volume which cannot be found.

––––––––––––––––––––––––––
The desktop files used for the
disc do not contain information
about the applications used to
create those files.

––––––––––––––––––––––––––

Uncheck the Resolve aliases
checkbox. The aliases are loaded
as aliases and are not resolved.
(They are displayed in italics.)

––––––––––––––––––––––––––
• Connect the respective

volume or
• Uncheck the option Resolve

aliases. These aliases will then
loaded as aliases and are not
resolved.

––––––––––––––––––––––––––
Before importing any data,
import a folder from the volume
which contains the respective
applications. Then the desktop
files from that volume will used
(see chapter 16 “The Format
Mac Files & Folders”).
––––––––––––––––––––––––––
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You wrote more than one HFS
session on the same disc. When
you insert the disc you only see
the first session.

––––––––––––––––––––––––––

Your current CD-ROM driver
does not support multisession
discs.

––––––––––––––––––––––––––

• If you have an Apple CD-
ROM Drive, install the Apple
CD-ROM driver version
5.1.x (or higher) or

• mount the disc using your
CD writer and the system
extension “Toast CD Reader”.

NOTE: Each HFS sessions is
mounted as an individual 
volume.
––––––––––––––––––––––––––
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“ISO 9660”

You want to back up your
Macintosh data using ISO
format. After importing the data,
all names are shortened and the
original names are displayed
beside the new names in gray
letters.
––––––––––––––––––––––––––
When you drag files and folders
onto the selection window you
get the following messages: 
Please insert disk…
At the File Server “The
Server” registered as…
Some aliases couldn’t be
resolved:
––––––––––––––––––––––––––
You drag files and folders onto
the selection window. You get
the following message:
Couldn’t complete the last
command because the volume
could not be found.
Error code = -35.
––––––––––––––––––––––––––
After importing all the data you
click Write CD…. The option
Write Session is not available.

––––––––––––––––––––––––––
After importing all the data you
click Check Speed… or Write CD…
and get the following message:
The ISO 9660 standard does
not allow more than 8 levels of
nested folders. The disc will
not conform to the ISO 9660
standard if you continue.
––––––––––––––––––––––––––

A naming option was chosen
which doesn’t allow more than
8.3 characters.

––––––––––––––––––––––––––
The option Resolve aliases was
checked. The selected data
contains aliases which point to
data which cannot be found.
This often happens when you
drag a System Folder containing
folders like “Recently used
applications” or similar.
––––––––––––––––––––––––––
The option Resolve aliases was
checked. The selected data
contains aliases which point to a
volume which cannot be found.

––––––––––––––––––––––––––
• Either there is not enough

free space on the disc to add
another session or

• You didn’t choose CD-ROM XA
for the format in the ISO
dialog.

––––––––––––––––––––––––––
The naming options were set to
Allow MS-DOS Names or ISO 9660
Level 1. Your data contain more
than 8 levels of nested folders.

––––––––––––––––––––––––––

In the ISO window click Settings
and choose Allow Macintosh
Names. 
Also check the option Use Apple
Extensions.

––––––––––––––––––––––––––
Uncheck the Resolve aliases
checkbox. The aliases are loaded
as aliases and are not resolved.
(They are displayed in italics.)

NOTE: Aliases only work on
the Mac!

––––––––––––––––––––––––––
• Connect the respective

volume or
• Uncheck the option Resolve

aliases. These aliases will then
loaded as aliases and are not
resolved.

––––––––––––––––––––––––––
• If there is not enough free

space on the disc the disc will
have to be closed. Click Write
Disc.

• Be sure to choose CD-ROM XA
for the format in Settings.

––––––––––––––––––––––––––
If you write this disc some files
may not be visible when reading
the disc on a PC. (It depends on
the particular ISO driver whether
more than 8 directory levels can
be accessed.)

––––––––––––––––––––––––––
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You wrote an ISO multisession
disc. If you read the disc on the
Macintosh, each session is
mounted as a separate volume,
but all sessions have the same
name and apparently the same
contents.

––––––––––––––––––––––––––
When you write a session to a
disc which already contains an
ISO session. You get the
following message:
The disc appears to be
damaged. Ignore existing
sessions?
––––––––––––––––––––––––––
You wrote a multisession disc.
When you insert the disc you
only see the data of the last
written session. Data from
former sessions is not visible.
––––––––––––––––––––––––––
You want to add a session to a
disc which already contains at
least one session. You click Write
CD… and get the following
message:
“Your Session” is in CD-ROM
format. It is recommended to
use CD-ROM XA for
multisession discs. Would you
like to change the format to 
CD-ROM XA?
––––––––––––––––––––––––––
You back up your data in ISO
multisession format. The writing
of the last session was aborted.
You cannot read any file on the
disc although you see them.

––––––––––––––––––––––––––

Some CD-ROM drivers are
buggy. Instead of showing only
the last session, all sessions are
mounted.

––––––––––––––––––––––––––
Important data could not be read
from the disc such as the TOC
(table of contents) or similar. 

––––––––––––––––––––––––––
When you wrote the last session
you chose the option Ignore
existing sessions or Incremental
Backup.

––––––––––––––––––––––––––
You didn’t choose CD-ROM XA
for the format options in the 
Settings window.

––––––––––––––––––––––––––
The TOC was written but
nothing else.

––––––––––––––––––––––––––

• Install the lastest Apple CD
drivers or

• read the disc with your writer
and the extension “Toast CD
Reader” or

• install other driver software,
e.g. “CD-ROM Toolkit™”
from FWB.

––––––––––––––––––––––––––
If you continue, the session will
be written as a separate volume. 

––––––––––––––––––––––––––
To recover the data of the
previous session choose Import 
Session in the ISO dialog. Import
the previous session and add the
data for the new session.
––––––––––––––––––––––––––
Click Change. If not you will not
be able to add any other data to
this disc later.

––––––––––––––––––––––––––
You can recover the data of the
previous session by using the
Import Session command in the
ISO dialog. Import the last 
session which was correctly
written and add the data for the
new session.
––––––––––––––––––––––––––

187Appendix B

Problem/Question Information Possible Solutions



You drag a volume onto the ISO
selection window. Items which
were on the desktop or in the
trash on the volume are not
shown in the list.
––––––––––––––––––––––––––
You wrote a disc with Macintosh
names. Some file names are not
shown like they were originally
defined. 

Therefore you get error reports
when comparing the disc with
the original data (when using
Compare from the Utilities menu).
––––––––––––––––––––––––––

There is neither a “Desktop
folder” or a “Trash” folder on
ISO discs so items in those
directories cannot be written to
an ISO disc.
––––––––––––––––––––––––––
Some ISO drivers cut the
following characters at the end
of a file name: “blank”, “;”, “.”,
“;number”.

––––––––––––––––––––––––––

If you want to write those items,
drag them onto the selection
window after dragging the 
volume.

––––––––––––––––––––––––––
Press the Option key while 
inserting the disc in the Mac.
Then all names are displayed in
their full length.

––––––––––––––––––––––––––
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“Mac/ISO Hybrid”

You have selected a volume for
the Macintosh part. In order to
share data with the ISO part you
drag files from the same volume
onto the ISO selection window.
You get the following message:
“Optimize for Speed” will be
used, because the allocation
block size of “Your Volume” is
not a multiple of 2 K.
––––––––––––––––––––––––––
You do not have a complete
volume available which only
contains the Macintosh and the
shared data.

––––––––––––––––––––––––––
You want to have shared data on
a Hybrid disc. You select all data
for the Macintosh and the ISO
part but no data is recognized to
be shared.

––––––––––––––––––––––––––
You wrote several Hybrid
sessions onto the same disc. You
get different results when
reading the disc on a Macintosh
or on a PC. 

––––––––––––––––––––––––––

You can only have shared data
on Macintosh volumes with an
allocation block size which is a
multiple of 2 K. 

Otherwise the optimizer has to
be used. 

––––––––––––––––––––––––––

––––––––––––––––––––––––––
In order to share data, they have
to be placed on the selected
Macintosh volume and they have
to be selected again for the ISO
part.

––––––––––––––––––––––––––
Hybrid discs should never be
written as multisession discs.

––––––––––––––––––––––––––

If your computer is not fast
enough to optimize on-the-fly:
• Save all data as a disc image

before writing -or-
• Use a temporary partition

created with Toast for the
Mac volume -or- 

• Reformat your hard disk with
a correct block size.

––––––––––––––––––––––––––
1) Choose the format Mac Files &

Folders and drag all desired
data onto the selection
window.

2) Save the data as a disc image.
3) Mount the disc image and use

it as the Mac data source
-or-
Create a temporary partition and
copy all the data into the
partition.
––––––––––––––––––––––––––
• Make sure that you import

the data from the already 
selected Macintosh volume in
the ISO dialog. 

• If the shared data was defined
using aliases, make sure that
the aliases point to items 
placed on the selected Mac
volume and that the option
Resolve aliases is checked.

––––––––––––––––––––––––––
On a PC you will only see the
last written session, on a
Macintosh you will either see
only the first session or all
sessions as single volumes
(depending on the installed
driver)
––––––––––––––––––––––––––
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You wrote a Hybrid track as the
second session of an audio CD.
When you insert the disc into
your CD-ROM drive you cannot
see any data, only audio tracks
are displayed.
––––––––––––––––––––––––––

Older CD-ROM drivers do not
read such discs correctly.

––––––––––––––––––––––––––

Install another CD-ROM driver:
Apple CD-ROM driver version
5.1.x or higher, “CD-ROM
Toolkit™” or use your writer
with the extension “Toast CD
Reader”.
––––––––––––––––––––––––––
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“Audio CD” / “Audio Tracks”
You drag an audio file onto the
audio selection window and get
the following message:
Only 16 bit/44 kHz sound can
be written. “Your File” is not
in this format.
––––––––––––––––––––––––––
Beside the name of the file
“Mono” is displayed in brackets.

––––––––––––––––––––––––––
You take an audio CD to a disc
replicator for duplication and
they report a problem with the
master.

––––––––––––––––––––––––––
You hear noises between audio
tracks although your original
data is correct.
––––––––––––––––––––––––––
Before writing you get the
following message:
Your recorder does not
support index generation.
All index markers will be
ignored.

The audio file has the wrong 
format.

––––––––––––––––––––––––––
The sound file was saved in
mono format.

––––––––––––––––––––––––––
Toast writes audio CDs using
“track-at-once” mode, but
replicators prefer auido master
discs written in “disc-at-once”
mode.
––––––––––––––––––––––––––
The firmware versions of some
writers cause clicks between
tracks.
––––––––––––––––––––––––––
Not all writers can write index-
points in track-at-once mode.

Save sound files in the following
format: 16 Bit, 44.1 kHz, stereo
or mono.

––––––––––––––––––––––––––
Mono files are converted into
stereo files where both channels
contain exactly the same sound
information.
––––––––––––––––––––––––––
Use a program like Toast CD-
DA to write your audio master.

––––––––––––––––––––––––––
Please contact your hardware
dealer to get a firmware update
for your writer.
––––––––––––––––––––––––––
If you need to have index-points
on the disc (they are very
seldom used) use another
application which writes in disc-
at-once mode, e.g. “Toast CD-
DA”.
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“CD-i”

You drag a disc image onto the
main window. Toast changes to
“Video CD” or “Disc Image”
format.
––––––––––––––––––––––––––
You selected a disc image after
clicking Data… in the CD-i
format. You write the disc but it
cannot be read by CD-i players.
––––––––––––––––––––––––––

Only images conforming to the
“green book” standard can be
written as CD-i.

––––––––––––––––––––––––––
The disc image might have had
the wrong format.

––––––––––––––––––––––––––

CD-i images can only be created
with special authoring software
as the structure defined in the
“green book” is very specific.
––––––––––––––––––––––––––
Drag the image onto the main
window. If it is not a CD-i image
Toast will change to the
appropriate format.
––––––––––––––––––––––––––
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“Video CD”

You import an MPEG stream
and get the following message:
“Your File” can not be used to
create a Video CD. Please use
the “Toast Ready” option in
ASTARTE M. Pack.
––––––––––––––––––––––––––
When a Video CD is created
from individual MPEG streams,
what functionality will be
available on the finished disc?

––––––––––––––––––––––––––
You drag an image file onto the
main window while the “Video
CD” format is selected. Toast
changes to the “Disc Image”
format.
––––––––––––––––––––––––––

The file does not contain the
required information to create a
Video CD.

––––––––––––––––––––––––––

––––––––––––––––––––––––––
Your file is not a valid Video CD
disc image.

––––––––––––––––––––––––––

Multiplexing has to be performed
with the software “ASTARTE
M. Pack” (version 1.02 or
above). The option Toast Ready
has to be checked.

––––––––––––––––––––––––––
There will be one menu which
allows you to play the videos,
stop, fast forward, rewind,
pause, go to next video track,
and go to previous video track.
––––––––––––––––––––––––––
Use a Video CD authoring
system to create a Video CD
disc image or import MPEG
streams created with “ASTARTE
M. Pack”.
––––––––––––––––––––––––––
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“Enhanced Music CD”

You select a volume in
“Enhanced Music CD” format
and get the following message:
“Your Volume” does not
contain a CD EXTRA
directory hierarchy or a QuAC
file. It can not be used to
create an Enhanced Music CD.

––––––––––––––––––––––––––
You wrote an “Enhanced Music
CD” track as second session of
an audio CD. When you insert
the disc in your computer you
can only see the audio tracks, no
data.

––––––––––––––––––––––––––
You put extra data into the folder
“CD EXTRA” in order to make
them visible on the PC. All file
and folder names are cut.

––––––––––––––––––––––––––
You get the following message
before writing:
The audio tracks will be
written into the second session.
Most likely this is not what
you want.
––––––––––––––––––––––––––

The structure of a CD EXTRA is
very restrictive (defined in the
“blue book”). Your volume does
not contain such a structure nor
does it contain a valid QuAC
file.

––––––––––––––––––––––––––
Older CD-ROM drivers do not
read such discs correctly.

––––––––––––––––––––––––––
Toast uses the naming
convention “Allow MS-DOS
names” for the ISO part of a CD
EXTRA (see chapter 16 “The
ISO 9660 Format”).
––––––––––––––––––––––––––
In order to play the audio tracks
on a CD player the tracks have
to be placed in the first session
of a disc. 

––––––––––––––––––––––––––

• Create a QuAC file with the
software “Apple Interactive
Music Toolkit™”.

• Create a CD EXTRA
hierarchy. Currently there is
no authoring system which
creates such a structure for
you. 
Experienced programmers
which have the “blue book”
specifications can create the
CD EXTRA structure
manually.

––––––––––––––––––––––––––
Install another CD-ROM driver:
Apple CD-ROM driver version
5.1.x or above, “CD-ROM
Toolkit™” or use your writer
with the extension “Toast CD
Reader”.

––––––––––––––––––––––––––
If don’t want Toast to transform
the names for you, make sure
that all names in the folder “CD
EXTRA” have a length of 8.3
characters.
––––––––––––––––––––––––––
For the first session of an
“Enhanced Music CD” only 
select audio files in the “Audio
CD” format. Then add the data
as a second session on the same
disc.
––––––––––––––––––––––––––
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“SCSI Copy”

You copied a SCSI hard drive.
The disc is not readable when
inserted into a CD-ROM drive.

––––––––––––––––––––––––––
You want to copy a disc directly.
While checking the data rate or
while writing you get an error
message.

––––––––––––––––––––––––––
You copy a bootable CD but the
copy is not bootable.

––––––––––––––––––––––––––

Almost no operating system
(except the Mac OS) is able to
read CD-ROMs which have the
same file system as a hard drive.
If you try to copy an MS-DOS
formatted hard drive directly,
you will not be able to read this
disc, since DOS expects a read-
only file system for CDs.
––––––––––––––––––––––––––
Not all CDs can be copied
directly. CDs containing mode 2
form 2 cannot be copied. These
are: Video CDs, CD-is, CD
EXTRAs, Photo CDs, etc..

––––––––––––––––––––––––––
The wrong options were set in
the SCSI Copy dialog.

––––––––––––––––––––––––––

Mount the respective hard drive
on the Macintosh and write the
data in the “ISO 9660” format
rather than using SCSI Copy.

––––––––––––––––––––––––––
Use another application to
extract the tracks of these discs
so that they can be written back
onto disc, e.g. “ASTARTE CD-
Copy”.

––––––––––––––––––––––––––
Click “Options…” and
UNCHECK the option “Clear
Driver Descriptor Map” before
copying the disc.
––––––––––––––––––––––––––
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“Disc Image”

You want to mount a disc image
and get the following message:
“Your File” is fragmented.
Please use a commercial Disk
Optimizer to defragment the
volume “Your Volume”. You
can also try to duplicate the file
or copy it to another volume.
––––––––––––––––––––––––––
You want to mount a disc image
and get the following message:
“Your File” could not be
mounted because it contains
an unknown file system. Most
likely the system extensions
files “Foreign File Access”
and/or “ISO 9660 File Access”
are not installed.
––––––––––––––––––––––––––
You want to save a disc image
and get the following message:
The image file could not be
created because the disk is
full: x MB are needed, y MB
are available.
––––––––––––––––––––––––––

Only defragmented disc images
can be mounted.

––––––––––––––––––––––––––
These files must be installed in
your system folder in order to
mount a disc image which is not
in Macintosh HFS format.

––––––––––––––––––––––––––
The selected volume does not
have enough free space to save
the image.

––––––––––––––––––––––––––

Defragment the volume which
contains the disc image (e.g. with
“Norton Speed Disk ™”). 

In some cases it might help to
duplicate the image or to copy it
to another volume.

––––––––––––––––––––––––––
Did you boot your Mac with all
extensions OFF?
Verify that the extensions folder
in your system folder contains
the files “Foreign File Access”
and “ISO 9660 File Access”.
Restart your Mac with
extensions ON.

––––––––––––––––––––––––––
Select another volume to save
the image.

––––––––––––––––––––––––––
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“Multitrack CD-ROM XA”

You add a file and get the
following message:
Warning: The length of “Your
File” is not a multiple of the
sector size.
––––––––––––––––––––––––––

The file is not a valid CD-ROM
XA file as it has an invalid
length.

––––––––––––––––––––––––––

You can write this file to disc,
but it might not be usable.

––––––––––––––––––––––––––
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Checking the Data Rate

You get the following message:
A RAM Cache of x MB was
requested but only y MB could
be allocated. To make more
memory available, try quitting
other running applications (if
any.)
––––––––––––––––––––––––––
You get the following message:
Couldn't complete the last
command because of a Mac
OS error.
Error code = 2.
––––––––––––––––––––––––––
Other problems related to
checking the data rate are 
explained in chapter 17.

A higher RAM cache than 
available RAM was defined in
Preferences (menu Edit).

––––––––––––––––––––––––––
The selected data cannot be read
by a Macintosh. This happens
e.g. when you try to copy a disc
which contains mode 2 form 2
or audio sectors.
––––––––––––––––––––––––––

If you don’t change anything,
Toast uses the maximum
available RAM for the RAM
cache. Quit other applications to
get more available RAM.

––––––––––––––––––––––––––
Extract the tracks of the disc
with appropriate software, e.g.
“ASTARTE CD-Copy”.

––––––––––––––––––––––––––
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Before Writing

You get the following message:
An unknown driver is installed
for SCSI ID x. If you run into
problems, please remember to
disable the driver next time.
––––––––––––––––––––––––––
You get the following message:
This recorder can not write a
CD-ROM track on a CD-ROM
XA, sorry.
––––––––––––––––––––––––––
You get the following message:
This recorder can not write a
CD-ROM XA track on a CD-
ROM, sorry.

––––––––––––––––––––––––––
You click Write Disc or Write 
Session and get the following
message:
Failed to allocate x MB of
temporary hard disk cache on
“Your Volume”. Please use the
“Preferences” menu item to
select a different volume.

––––––––––––––––––––––––––
The option Write Session is not
available in the write dialog.

Some drivers cause problems
during writing. These could be
other CD-writer drivers, scanner
drivers, etc..

––––––––––––––––––––––––––
Some writers do not allow
mixing formats on a disc. The
inserted disc contains at least
one CD-ROM XA track.
––––––––––––––––––––––––––
Some writers do not allow
mixing formats on a disc. The
inserted disc contains at least
one CD-ROM track.

––––––––––––––––––––––––––
The selected data contains many
small files which have to be
saved to the temporary hard disk
cache in order to avoid speed
problems while writing. 
The selected hard disk does not
have enough free space to save
all the required files.

––––––––––––––––––––––––––
• You have selected more than

625 MB of data to write.
• There is not enough free

space on the disc to write
more sessions after the 
current one.

• You chose “ISO 9660” or
“Mac/ISO Hybrid” format
and you did not choose the
option CD-ROM XA for the
format settings.

If you are running System 7.5.x,
boot with all extensions off
(shift-boot). With other System
versions, disable all extensions
which are not needed to write.
––––––––––––––––––––––––––
Select the data in “ISO 9660” or
“Mac/ISO Hybrid” format and
choose CD-ROM XA for the format
settings.
––––––––––––––––––––––––––
• Select the data in “Mac Files

& Folders” or “Mac Volume”
format. 

• If you wish to use the “ISO
9660” or “Mac/ISO Hybrid”
format, choose CD-ROM for
the format settings. The disc
is closed after this session
(Write Session is not available).

––––––––––––––––––––––––––
• Choose Preferences from the

Edit menu and select another
hard drive which contains
more free space than the 
currently selected.

• Or create a disc image of the
selected data (then no
temporary hard disk cache is
needed). 

––––––––––––––––––––––––––
• There wouldn’t be enough

space for another session, so
Toast disables that option.

• Use a blank CD-R.

• Choose CD-ROM XA for the
format settings in the ISO
dialog Settings.
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You get the following message:
You can not write this disc
with the selected recorder.

––––––––––––––––––––––––––
More problems appearing before
writing are explained in chapter
17.

Not all writers can write all disc
formats.
This message mostly appears
when writing the following
formats with some writers:
Video CD, CD-i, Multitrack CD-
ROM XA, Enhanced Music CD.
––––––––––––––––––––––––––

Please contact your dealer. There
might be a firmware update for
your writer which enables it to
write these kinds of discs.

––––––––––––––––––––––––––

200 Troubleshooting

Problem/Question Information Possible Solutions



201Appendix B

Problem/Question Information Possible Solutions

While Writing

You get the following message:
SCSI Error: 
The SCSI connection is not
stable. Please check the cables
and termination.

––––––––––––––––––––––––––
You get the following message:
The drive reported an error::
Sense Key = … 
Sense Code = 0x…
Description

----------------------------------------
Description = 
BUFFER UNDERRUN

----------------------------------------
Description = 
TRACK FOLLOWING ERROR

----------------------------------------
Sense Key = 
HARDWARE ERROR

----------------------------------------
Sense Key = 
MEDIUM ERROR

This message only appears with
unstable SCSI connections.
Cables, terminators or SCSI
ports might be damaged.

––––––––––––––––––––––––––
These messages are sent from
the writer and are different for
each brand/model of writer.

----------------------------------------
The writer’s data buffer ran out
while writing. If this happens the
write procedure will be aborted
and the disc will be unusable.

----------------------------------------
This is a calibration problem.
The write laser is not able to find
the last bit of data on the disc.

----------------------------------------
These errors are mostly
generated by the writer’s
hardware. The writer might be
damaged.
----------------------------------------
Most of these errors occur
because of problems with the
particular brand or batch of 
CD-Rs you are using.

Check cables and termination.
The problems might not be
apparent in normal disk
operations, but writing a disc
requires perfect SCSI
connections!
––––––––––––––––––––––––––
If you get an error which is not
explained in this section please
write down the Sense Code and
the Description before requesting
technical support. This will be a
big help in resolving the
problem.
----------------------------------------
• Disable all system extensions

which are not needed.
• Remove all drives from the

SCSI chain which are not
needed.

• Check cables and terminator.
Replace them if necessary.

• Choose a lower write speed.
• Increase the RAM cache in

Preferences from the Edit menu.
----------------------------------------
• Your recorder is not level.
• The inserted CD-R is

damaged.
• The brand of media is not

compatible with your writer.
• The writer’s calibration

mechanism is defective.
----------------------------------------
If errors of this kind occur
frequently please contact our
technical support.
----------------------------------------
Change the brand of CD-Rs.
There are big differences in 
quality.



After Writing

While verifying you get the
following message:
Mismatch at byte x/sector y.
Verification failed.
–––––––––––––––––––––––––––
The Verify button is not available.

–––––––––––––––––––––––––––

While comparing the disc with
the original data a mismatch was
found.

–––––––––––––––––––––––––––
You probably selected one of
these formats: Audio CD, Video
CD, CD-i, Enhanced Music CD,
Multitrack CD-ROM XA.
–––––––––––––––––––––––––––

Verify the disc by choosing the
Compare command (Utilities
menu).

–––––––––––––––––––––––––––
Only discs that are readable by
the Mac can be verified.

–––––––––––––––––––––––––––
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